right people
right places
right time

user guide

right now
Meeting Maker, Inc. End User License Agreement
Web Site: http://www.meetingmaker.com

BEFORE OPENING THE PACKAGE CONTAINING THE PROGRAM CD (OR CLICKING “ACCEPT” IF YOU ARE READING THIS LICENSE ON A COMPUTER SCREEN), YOU MUST READ THIS LICENSE AGREEMENT CAREFULLY.

OPENING THIS PACKAGE OR CLICKING “ACCEPT” MEANS THAT “YOU” ARE AUTHORIZED TO ACCEPT THIS AGREEMENT, THAT YOU HAVE READ AND UNDERSTAND ITS TERMS AND THAT YOU AGREE TO BE BOUND BY IT.

IF YOU DO NOT AGREE WITH ANY PART OF THIS AGREEMENT, YOU MAY NOT INSTALL OR USE THE PROGRAM, AND MUST IMMEDIATELY RETURN IT UNOPENED TO THE PLACE WHERE IT WAS ACQUIRED FOR A FULL REFUND.

FOR PURPOSES OF THIS AGREEMENT, “YOU” INCLUDES YOURSELF AND ANY ORGANIZATION OR INSTITUTION LICENSING THE PROGRAM OR ON WHOSE EQUIPMENT THE SOFTWARE MAY BE INSTALLED OR USED.

1. LICENSE GRANT
In consideration for the license fee paid, Meetingmaker, Inc. (hereafter “MM”), grants to You, a non-exclusive, restricted right to use the “Program” (in machine readable form only and including all associated materials) solely for Your personal or internal business purposes, in accord with the terms of this Agreement.

Number of Users. You may use the Program only for one User, unless You and MM specifically agree that You may use the Program for a larger number of users or install it on a larger number of machines.

Copies; Prohibited Uses. You may make one copy of the Program for backup purposes only. You may not use or provide access to the Program or use the Program for any purpose other than Your personal or internal business purposes. You may not use the Program to provide services to any third party without MM’s express written consent. You may not modify, adapt, translate, reverse engineer, decompile, disassemble, or create derivative works based on the Program without MM’s prior written consent. (All information necessary to achieve interoperability is available in accord with applicable provisions of European Union and other government directives). You may not remove any disclaimer, copyright, trademark, proprietary rights, or other notice included on or embedded in the Program.

Transfers. You may transfer the Program on a permanent basis (if not otherwise prohibited by Your agreement with MM), provided that You first inform MM in writing of the name and address of the recipient to which the Program will be transferred, You transfer all associated documentation, You retain no copies, and the recipient first agrees in writing to the terms of this Agreement. Please contact MM for appropriate transfer documentation.
2. OWNERSHIP
MM owns or licenses, and retains all title, copyright, trademark, trade secret, patent, and other proprietary rights in and to the Program. This license is NOT a sale of the Program or any copy of it. You obtain only the rights specified in this Agreement. MM reserves all rights not specifically granted.

3. TERM & TERMINATION
This Agreement is effective until terminated. MM may terminate this Agreement on written notice if You breach any provision of this Agreement. On termination, You must destroy or return to MM all copies of the Program, including all associated materials. This license may terminate after a limited period (e.g. three (3) years) if You (or Your institution or employer) have agreed to a Lease Program.

4. LIMITED WARRANTY
The Program is a tool which MM hopes You will find useful. However You are solely responsible for the selection, use, performance, backup, and results associated with any Program use. MM does not warrant that the functions contained in the Meetingmaker Program will meet Your requirements or that Program operation will be uninterrupted or error free.

MM warrants any medium on which the Program is provided to be free from defects in materials and workmanship under normal use for a period of ninety (90) days from the date of delivery as shown on Your receipt. MM shall have no responsibility if failure results from accident, abuse or misapplication, or if any medium is lost or damaged due to theft, fire, or negligence. Any replacement medium will be warranted for the remainder of the original warranty period or thirty (30) days, whichever is longer. This warranty gives You specific legal rights. You may have other rights which may vary from jurisdiction to jurisdiction. EXCEPT AS EXPRESSLY PROVIDED ABOVE, ALL PROGRAMS ARE PROVIDED “AS IS”. MM DOES NOT MAKE ANY WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF NONINFRINGEMENT, MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THIS WARRANTY WILL NOT BE ENLARGED OR AFFECTED BY ANY MM TECHNICAL OR OTHER ADVICE IN CONNECTION WITH THE PROGRAM.

5. LIMIT OF REMEDIES & LIABILITY
MM’s entire liability and Your exclusive remedy for any claim ASSOCIATED WITH THE PRODUCT OR THIS AGREEMENT shall be, at MM’s SOLE option, return of purchase price or replacement of any medium returned to MM with a copy of the receipt. NOTWITHSTANDING ANY OTHER PROVISION OF THIS OR ANY OTHER AGREEMENT, MM SHALL NOT BE LIABLE FOR (1) ANY SPECIAL, INDIRECT, CONSEQUENTIAL, OR INCIDENTAL DAMAGES (INCLUDING BUT NOT LIMITED TO INACCURACY OF ANY DATA OR COST OF PROCUREMENT OF SUBSTITUTE GOODS, SERVICES OR TECHNOLOGY, OR LOSS OF PROFITS, DATA OR USE) ARISING OUT OF OR IN CONNECTION WITH ANY USE OR INABILITY TO USE THE PROGRAM OR ANY MM SERVICES WHICH MAY BE PROVIDED, OR ANY CAUSE RELATED THERETO, EVEN IF MM HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES; AND (2) ANY AMOUNT IN EXCESS OF THE LESSER OF THE PRICE, FEE OR CHARGE THEREFOR RECEIVED BY MM FOR PRODUCT OR SERVICE. Because some jurisdictions do not allow the exclusion or limitation of liability for consequential or incidental damages, some or all of the above limitations may not apply to You.
6. U.S. GOVERNMENT RESTRICTED RIGHTS
This program is a “commercial item” as defined in 48 C.F.R. 2.101 (Oct. 1995) consisting of “commercial computer software” and “commercial computer software documentation” as such terms are used in 48 C.F.R. 12.212 (Sept. 1995) Consistent with 48 C.F.R. 12.212 and 48 C.F.R. 227.7202 (-1 through -4) (June 1995), all government entities which acquire the Program, do so only with the rights set forth in the license provided with the Program and this Agreement. Contractor/manufacturer is Meetingmaker, Inc./P.O. Box 219, First Home Tower, British American Centre, George Town, Grand Cayman.

7. CONFIDENTIAL INFORMATION
You agree that all MM-furnished information which is labeled “confidential” or the like (“Confidential Information”) contains valuable proprietary information and/or trade secrets developed by MM or its licensor at great expense. You will hold this Confidential Information in confidence and will not use, reproduce or distribute it except to Your employees (and agents who agree to this provision) who may use it only as part of their responsibilities to You. You will report any unauthorized use or disclosure of any Confidential Information.

8. EXPORT LAWS.
The Program may not be exported or reexported in violation of U.S. export laws, including the U.S. Export Administration Act and implementing regulations.

9. GOVERNING LAW
This Agreement is a Massachusetts contract, and shall be governed solely by the laws of Massachusetts, USA, without reference to its conflict of law provisions or the UN Convention for the International Sale of Goods. Any action relating to this Agreement, the parties’ relationship, or the Program or goods or services provided, purchased or licensed hereunder, shall be brought and tried in Massachusetts.

10. ENTIRE AGREEMENT
This Agreement (including any supplemental terms agreed in writing, e.g. for a Site License, Enterprise License, or Maintenance) constitutes the complete and exclusive agreement between You and MM and supersedes any proposal or prior agreement or other communication with MM relating to the subject of this Agreement. This Agreement may be modified only by a writing which specifically references this Agreement and is signed by both You and a MM officer.

Note: If You have any questions concerning this Agreement, or desire to contact MM for any reason, You may do so through the distributor from which You obtained the Program or the sales representative offices listed below:
FOR NORTH AMERICAN INSTALLATIONS:

Meeting Maker, Inc.
Waltham Woods
880 Winter Street, Building 4
Waltham, MA 02451 – 1449 USA
Main Number: +1 781 487 3538
Main Fax: +1 781 487 3502
Email: mmsales@meetingmaker.com

FOR EUROPEAN & OTHER INSTALLATIONS:

Meetingmaker- Europe
3000 Hillswood Drive
Hillswood Business Park
Chertsey, KT16 ORZ UK
Phone: +44(0) 1932 895 301
Fax: +44 (0) 870 162 9220
Email: europe@meetingmaker.com
Contents

Preface ................................................................. 17
About this Book ..................................................... 17
Documentation Conventions ....................................... 18
Technical Assistance ............................................... 19

1 Getting Started .................................................. 21
About meetingmaker ................................................. 22
How meetingmaker Works ......................................... 23
How meetingmaker Can Help You ............................... 23
Getting Started with meetingmaker for Windows ........... 25
Windows Hardware and Software Requirements ............ 25
Installing meetingmaker for Windows from a CD ........... 25
Installing meetingmaker for Windows from a File Server ... 26
Signing in to meetingmaker for Windows ..................... 27
Getting Started with meetingmaker on a Macintosh ......... 30
Macintosh Hardware and Software Requirements .......... 30
Installing meetingmaker for the Macintosh from a CD .... 30
Installing meetingmaker for the Macintosh from a File Server 32
Signing in to meetingmaker on a Macintosh ................. 32
Getting Started with meetingmaker for Solaris ............... 35
Solaris Hardware and Software Requirements ............... 35
meetingmaker in the Solaris Environment ................... 35
Installing meetingmaker Client Software for Solaris ...... 36
Signing in to meetingmaker on Solaris ....................... 36
Passwords ............................................................. 38
Exiting and Signing Out of meetingmaker ..................... 38
2 Quick Start Tutorial ........................................ 39
  Proposing a Meeting ....................................... 40
  Scheduling an Activity .................................... 41
  Creating a To-Do Item ..................................... 42
  Responding to a Meeting Proposal ......................... 43
  Responding to a To-Do Proposal ........................... 43
  Assigning a Proxy .......................................... 44
  Acting as a Proxy ........................................... 44

3 meetingmaker Basics ................................. 45
  Daily Calendar ............................................. 46
    Using the Daily Calendar ................................. 46
    Daily Calendar Shortcuts ............................... 48
    Daily Calendar Symbols ................................ 48
    Changing your Display Time Zone ...................... 49
    Viewing Hidden Events on the Daily Calendar .......... 50
    Labels ..................................................... 51
  Monthly Calendar ......................................... 51
    Monthly Calendar Shortcuts ............................ 52
  Searching Your Calendar .................................. 54
  Master Schedule ........................................... 55
    Accessing Recently Viewed Master Schedules .......... 56
    Viewing the Master Schedule ............................ 57
    Viewing the Master Schedule in a Different Time Zone 58
    Setting Master Schedule Preferences .................. 59
    Using the Master Schedule ............................... 59
    Master Schedule Shortcuts .............................. 59
    Master Schedule Uses .................................. 60
  Using the Navigator ....................................... 61
  Using Preferences ......................................... 62
    Changing Your Login Preferences ...................... 63
    Changing Notification Preferences .................... 65
    Changing Calendar Preferences ....................... 67
    Changing Labels Preferences ......................... 69
    Changing To-Do Preferences ............................ 70
    Changing Master Schedule Preferences ............... 71
    Changing General Preferences ....................... 72
    Changing Locale Preferences .......................... 74
  User Info .................................................. 76
    Changing your Work Hour Time Zone ................... 77
4 **meetingmaker Meetings** ........................................... 79
   Proposing Meetings .................................................. 80
   Selecting Guests ..................................................... 81
   Inviting a Guest to a Meeting ...................................... 81
   Inviting Multiple Guests to a Meeting .......................... 82
   Searching for a Guest .............................................. 83
   Additional Guest Information ...................................... 84
   Inviting Guests ..................................................... 85
   Shortcuts to Selecting Guests ..................................... 87
   Creating Contacts for Your Guest Lists ......................... 88
   External Guests and Contacts ...................................... 88
   Creating External Guests as “Contacts” ......................... 89
   Inviting External Guests/Contacts ............................... 90
   Configuring meetingmaker for External Guests/Contacts ...... 90
   Editing Contacts .................................................... 91
   Using Your QuickList .............................................. 91
   Creating Groups ..................................................... 92
   Finding a Meeting Time ............................................ 93
   The Composite Schedule ........................................... 93
   Scheduling Recurring Meetings .................................... 94
   Setting an Agenda .................................................. 95
   Specifying Reminder and Label Options ........................ 96
   Flexible and Private Events ....................................... 97
   Comments .......................................................... 97
   Sending the Meeting Proposal ..................................... 97
   Proposing a Meeting While Working Offline .................... 98
   Monitoring Meeting Responses .................................... 99
   Changing a Scheduled Meeting .................................... 100
      Changing a Recurring Meeting ................................ 101
      Canceling a Scheduled Meeting ............................... 101
   Meeting Notification ................................................ 102
   Responding to Meeting Proposals ................................ 102
      Changes to a Planned Meeting ................................ 103
      Changing a Refusal to an Acceptance ....................... 103
   Public and Personal Groups ....................................... 104
      Modifying Personal Groups .................................... 105
      Removing Personal Groups ..................................... 105
   Scheduling Resources .............................................. 106

5 **Activities and Banners** .............................. 107
   Activities .......................................................... 108
   Scheduling an Activity ............................................ 108
      Entering an Activity on Your Schedule ...................... 108
Contents

Activity Notes ................................................................. 110
Specifying Reminder and Label Options ............................. 110
Color-Coded Labels .......................................................... 110
Flexible and Private Activities .......................................... 111
Modifying Scheduled Activities ....................................... 111
Changing an Activity to a Meeting .................................... 112
Banners ................................................................. 113
Adding a Banner .......................................................... 113
About the Banner Information Screen ............................... 113
Creating a Banner ........................................................ 115
Entering Banner Notes .................................................... 116
About the Reminder and Banner Options ......................... 116
Defining the Reminder Options ...................................... 117
Adding Color to a Banner ............................................... 117
Defining the Viewing Status of a Banner ......................... 118

6 Proposals ................................................................. 119
The Proposals Window .................................................... 120
Active Proposals ........................................................... 120
To-Do Proposals ............................................................ 121
Your Proposals .............................................................. 122
Your Refusals ............................................................... 122
CC Proposals ............................................................... 123
CC To-Do Items ............................................................ 123
Sorting Proposals ........................................................... 124
Deleting Proposals ......................................................... 124

7 Messages ................................................................. 125
The Messages Window ..................................................... 126
Working with the Messages Window ................................. 127
Types of Messages ........................................................ 127
Working with Messages .................................................. 127
Reminder Messages ....................................................... 128
Instant Messages .......................................................... 128

8 To-Do Lists ............................................................... 131
Creating a To-Do List ...................................................... 132
Creating Individual To-Do Items .................................... 132
Creating Group To-Do Items .......................................... 134
Responding to a Group To-Do Request ......................... 134
Changing the To-Do List ................................................ 136
Changing To-Do Item Details ......................................... 136
9 Proxies ................................. 139
  Assigning Proxies ......................... 140
  Messages ........................................ 141
  Private Meetings, Activities and To-Do Items .... 141
  Accessing Another User’s Calendar as a Proxy .... 142
    Receiving Another User’s Notifications ...... 142
    Viewing Another User’s Calendar in a Different Time Zone .... 143
    Viewing Several Calendars at Once ........ 144
  Resource Proxies ......................... 144

10 Printing ................................. 145
  Printing Your Calendar ..................... 146
    Printing a Single Event, Message, To-Do Item or Banner . 147
  Printing Your To-Do List .................... 148
    Printing a Single To-Do Item ...... 148
    Printing a List of To-Do Items .... 148
    Printing One To-Do Item Per Page .... 148
  Printing Your Contact List ................ 150
    Printing a Single Contact ... 150
    Printing a List of Contacts .... 150
    Printing One Contact Per Page ...... 150
  Printing Your Proposals ................... 152
    Printing a Single Proposal .... 152
    Printing a List of Proposals .... 152
    Printing One Proposal Per Page .... 152
  Printing Your Messages .................... 154

11 Synchronizing Your meetingmaker Calendar with Palm OS Handheld Devices .......... 157
  Installing and Configuring the meetingmaker Conduits on Windows .... 158
    System Requirements ...... 158
    Setup .................. 158
    Installation ....... 158
    Configuring Synchronization .... 159
  Installing and Configuring the meetingmaker Conduits on Macintosh .... 165
    System Requirements ...... 165
Contents

Setup ......................................................... 165
Installation ................................................. 165
Configuring Synchronization ................................. 166
Synchronizing with meetingmaker ............................. 171
Restrictions of the meetingmaker Conduits ................. 171

12 Internet HTML Publisher ................................. 173
  Internet HTML Publisher Requirements ..................... 174
  System Requirements ...................................... 174
  Web Browser Requirements ................................ 174
  Publishing your Calendar with the Publish Feature ......... 175
  Publishing your Calendar with the Real-Time HTML Publisher Servlet ...................... 178
  Calendar Views ........................................... 179

13 meetingmaker Java Client ................................. 183
  System Requirements ...................................... 184
  Signing in to the meetingmaker Java Client ................. 184
  Using the meetingmaker Java Client ......................... 186
    Proposing a Meeting .................................. 186
    Creating an Activity ................................... 187
    Viewing Messages and Receiving Invitations .............. 188
    Setting Reminders ..................................... 190
    Creating a To-Do List .................................. 190
    Creating a Contact List ................................ 191
    Proxies .................................................. 192
    Editing User Preferences ................................. 193
    Other Java Client Features ............................... 194

A Troubleshooting ........................................... 195
  Questions and Answers ................................... 196
  Installation and Signing In ............................... 196
  Meetings/Activities ...................................... 198
  Proxies .................................................... 200
  Printing .................................................... 200
  UNIX ....................................................... 201
  meetingmaker Support ...................................... 202
    Before Calling Support .................................. 202
    When Calling Support .................................... 202

B Icons, Shortcuts, and Menus ............................... 205
  Icons ....................................................... 206
  Guest List ................................................. 206
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Daily Calendar</td>
<td>207</td>
</tr>
<tr>
<td>Shortcuts</td>
<td>208</td>
</tr>
<tr>
<td>Calendar Shortcuts</td>
<td>208</td>
</tr>
<tr>
<td>Menu Shortcuts</td>
<td>209</td>
</tr>
<tr>
<td>Menus</td>
<td>210</td>
</tr>
<tr>
<td>File Menu</td>
<td>210</td>
</tr>
<tr>
<td>Edit Menu</td>
<td>212</td>
</tr>
<tr>
<td>Label Menu</td>
<td>212</td>
</tr>
<tr>
<td>Proxy Menu</td>
<td>212</td>
</tr>
<tr>
<td>View Menu</td>
<td>213</td>
</tr>
<tr>
<td>Window Menu</td>
<td>213</td>
</tr>
<tr>
<td>Glossary</td>
<td>215</td>
</tr>
<tr>
<td>Index</td>
<td>219</td>
</tr>
</tbody>
</table>
meetingmaker® is a network group scheduling tool that lets users maintain personal calendars and arrange meetings with other meetingmaker users.

meetingmaker is a cross-platform application. The meetingmaker client runs on Windows 95, 98, Me, NT, 2000, Macintosh 8.6.1 or later, and Solaris. meetingmaker works similarly on all platforms, and the interface is virtually identical.

Note: Future versions of meetingmaker will support Macintosh OS X.

About this Book

This meetingmaker User Guide provides the basic information needed to get started using meetingmaker.

Topics include:

- Getting started
- Quick start tutorial
- meetingmaker basics
- meetingmaker meetings
- Activities and banners
- To-do lists
- Messages
The guide also contains a glossary of terms used in the product and documentation.

This guide assumes that you are familiar with the basic operation of your computer.

The screen illustrations in this guide are taken from different platforms. Therefore, the screen illustration for a given task may not look exactly as it appears on your monitor.

---

**Documentation Conventions**

This manual uses the following typographical conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>bold</strong></td>
<td>In a procedure, indicates a button, dialog box item, menu selection, or other item which requires an action from you. Also specifies the exact characters or values that you type into a field.</td>
</tr>
<tr>
<td><em>Italic</em></td>
<td>Indicates a placeholder for information or parameters you must provide. Also indicates the name of other manuals in the meetingmaker documentation set.</td>
</tr>
<tr>
<td><strong>Monospace</strong></td>
<td>Indicates fixed names in text, such as filenames and pathnames. Also used in syntax definitions and code fragments.</td>
</tr>
<tr>
<td><strong>UPPERCASE</strong></td>
<td>Indicates a parameter name or acronym.</td>
</tr>
</tbody>
</table>
Technical Assistance

You can call the meetingmaker technical support staff for assistance. If you encounter a problem, first make sure you have satisfied the system requirements listed in this guide. If you still need to contact support, gather as much detailed information about the problem as possible.

You can reach meetingmaker Technical Support by:

- Telephone at 781-487-3537. Support hours are Monday through Friday 9:00 a.m. to 5:30 p.m. US Eastern Time. If you contact meetingmaker Technical Support by phone, it is helpful to be at the computer where the issue occurred, in case it is necessary to assist support in recreating the problem.
- E-mail support at mmhelp@meetingmaker.com
- Web support at http://support.meetingmaker.com
Before contacting technical support, verify the following information:

- That your workstation meets the hardware and software requirements listed in the meetingmaker documentation.
- That meetingmaker was installed correctly. If necessary, re-install meetingmaker according to the directions in the meetingmaker Installation Guide.
- That your problem is not already listed in the Troubleshooting section of the meetingmaker User Guide or in the Technical Support searchable knowledge base, which is available on the Web at http://support.meetingmaker.com
- That your problem is not being caused by a virus. As a precaution, use a virus protection program or extension on a regular basis.

If possible, please have the following information ready when you call:

- A full description of the problem and steps to reproduce it
- The meetingmaker software version number
- The vendor name and model of the server and client system
- The version number of the server’s and clients’ operating systems
- The Macintosh control panels, chooser, and system or network extensions running on the computer, if applicable
- Your customer number
- Your phone and fax numbers, and email address
CHAPTER 1

Getting Started

This chapter describes how meetingmaker works, as well as how to install and sign in to meetingmaker.

Topics include:

• meetingmaker overview
• Getting started with meetingmaker for Windows
• Getting started with meetingmaker for Macintosh
• Getting started with meetingmaker for Solaris
• Passwords
• Exiting and signing out of meetingmaker
About meetingmaker

meetingmaker is a group scheduling tool that makes it easy to schedule meetings, plan activities, keep a prioritized to-do list, and coordinate your calendar with other meetingmaker users on a network.

The following illustration shows the four main meetingmaker windows:
CHAPTER 1: Getting Started

How meetingmaker Works

meetingmaker is a client-server software application. It requires one workstation to function as a meetingmaker Server which handles communications among Clients (users’ workstations). The Server stores meetingmaker data for all users, processes meetingmaker tasks, and sends notifications and messages among users.

How meetingmaker Can Help You

meetingmaker provides a convenient way to coordinate the schedules of people who work together. Use meetingmaker to do the following tasks:

**Plan and schedule meetings**
Send invitations, reserve meeting rooms and equipment (like slide projectors, VCRs, etc.) and schedule recurring meetings. meetingmaker’s Auto-Pick feature finds the earliest time that all required guests can attend your meeting.

**Organize your personal calendar**
Organize your personal calendar and keep other meetingmaker users aware of your availability for meetings. meetingmaker also reminds you of upcoming meetings and activities.

**Let someone else keep track of your calendar**
Assign a proxy to arrange your meetings, answer your messages, and schedule your activities. You can control whether the proxy can read or update your calendar, and whether or not the proxy sees descriptions of your activities or to-do items.

Note: Proxies are people you assign to help manage your calendar (such as a secretary or supervisor).

**Maintain a list of tasks**
Use the To-Do List to organize and prioritize important tasks. You can also assign to-do tasks to other people who are part of your meetingmaker environment.
About meetingmaker

Print your schedule
Print your schedule in sizes to fit your choice of popular personal organizers, including Day-Timer®, Day Runner®, Franklin Day Planner, and Dynodex.

Take your calendar with you
You can use your meetingmaker calendar even when not connected to the network by working "offline."

Synchronize your calendar with a handheld device
You can synchronize your meetingmaker calendar with Palm OS paltform handheld devices, such as those made by Palm and Handspring.
Getting Started with meetingmaker for Windows

To begin using meetingmaker for Windows, follow these steps:
1. Check hardware and software requirements.
2. Install the meetingmaker Client software.
3. Sign in to meetingmaker.

Windows Hardware and Software Requirements

meetingmaker requires the following hardware and software:

<table>
<thead>
<tr>
<th>Hardware/Software</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>486 or better</td>
</tr>
<tr>
<td>OS</td>
<td>Windows 95, 98, Me, NT, (3.51 or 4), or 2000</td>
</tr>
<tr>
<td>Ram</td>
<td>8 MB of free RAM</td>
</tr>
<tr>
<td>Disk</td>
<td>5 MB of free disk space</td>
</tr>
<tr>
<td>Network</td>
<td>10/100 megabit Network Interface Card, TCP/IP</td>
</tr>
</tbody>
</table>

Installing meetingmaker for Windows from a CD

To install the meetingmaker Client software:
1. Start the PC workstation and launch your Windows operating system.
2. Insert the meetingmaker CD into the CD-ROM drive.
3. Access the Run dialog box using the appropriate Windows system conventions.
4. Run setup.exe.
   Installation begins and the Welcome screen displays
5. Click **Next**. The Choose Destination Directory screen displays:

![Choose Destination Directory](image)

6. Click **Next** to place meetingmaker in the default directory. To place meetingmaker in a different directory, click **Browse** or type the directory name, then click **Next**. Installation continues.

Note: If you are upgrading from a previous version of the meetingmaker Client, the Local Data Options dialog displays. Choose whether you want to archive your local data, delete it, or leave it alone. Meeting Maker recommends that you archive local data.

7. When notified that installation is complete, choose whether you want to view the ReadMe file and if you want to launch the meetingmaker Client. Click **OK**.

From here, you can continue to “Signing in to meetingmaker for Windows” on page 27.

**Installing meetingmaker for Windows from a File Server**

Installing meetingmaker from a server requires read/write access to the directories containing the meetingmaker files. Make sure that your PC workstation conforms to the hardware and software requirements listed in “Windows Hardware and Software Requirements” on page 25.

- **To install meetingmaker to a Windows workstation from a network file server:**
  1. Launch Windows.
2. Access the Run dialog box using the appropriate Windows system conventions. The Run dialog box displays:

![Run dialog box]

3. In the Command Line, enter the path to the network directory containing the meetingmaker Client software (or use Browse to locate the directory), followed by setup.exe, then click OK. Installation begins.

Note: Contact your meetingmaker administrator for the path to the network directory containing the meetingmaker Client software.

4. Follow the on-screen instructions.

5. Click OK when notified that the installation is complete.

**Signing in to meetingmaker for Windows**

Once meetingmaker is installed, you can sign in and begin scheduling meetings with other meetingmaker users on your network.

- **To sign in to meetingmaker:**
  1. Launch Windows.
  2. From the meetingmaker program group, double-click the meetingmaker icon or choose meetingmaker from the Start Menu. The meetingmaker sign-in dialog box displays:

![Meetingmaker sign-in dialog box]

3. Enter your sign-in name and password in the sign-in dialog box. If you don’t know your sign-in name, ask your meetingmaker administrator.

Note: Your sign in name may appear in the box. If another name appears, delete it and enter your sign-in name.

4. Click the Server Select button. The Select Server dialog box displays:

5. Select the correct protocol.

Note: Your meetingmaker administrator can tell you which protocol to choose.

6. Click Configure. The Configure IP dialog box displays:

7. Enter the DNS host or the meetingmaker Server’s IP address.

Note: Your meetingmaker administrator can give you the DNS host or IP address to enter here.

8. Click OK.

9. Select a Server and click Select.

Note: Your meetingmaker administrator can tell you which server to choose.
10. Click the time zone **Select** button in the sign-in dialog box. The Select a Time Zone dialog box displays:

This is your "display" time zone. When you select a display time zone, meetingmaker shows your calendar in the time zone you select. Normally, you should select the time zone in which you live, or spend the majority of your work hours. However, when traveling in a different time zone, for example, you may wish to see your calendar in local time. In this case, select the time zone in which you are traveling.

**Note:** For more information on display time zones, see “Changing your Display Time Zone” on page 49.

11. Select your time zone and then click **OK**.

12. Click **Sign In**.
Getting Started with meetingmaker on a Macintosh

To begin using meetingmaker on a Macintosh, follow these steps:

- Check hardware and software requirements.
- Install meetingmaker Client software.
- Sign in to meetingmaker.

Macintosh Hardware and Software Requirements

meetingmaker requires the following hardware and software:

<table>
<thead>
<tr>
<th>Hardware/Software</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Macintosh Power PC or better</td>
</tr>
<tr>
<td>OS</td>
<td>8.6.1 or later</td>
</tr>
<tr>
<td>Ram</td>
<td>4 MB of free RAM</td>
</tr>
<tr>
<td>Disk</td>
<td>6 MB of free disk space</td>
</tr>
<tr>
<td>Network</td>
<td>10/100 megabit Network Interface Card, TCP/IP</td>
</tr>
</tbody>
</table>

Installing meetingmaker for the Macintosh from a CD

You can install meetingmaker on a Macintosh from the meetingmaker CD using either the Easy or Custom Install option:

- Easy Install automatically installs the meetingmaker application, exporters and print layouts.
- Custom Install lets you select and install desired items as needed.

If your meetingmaker administrator has installed meetingmaker on your Macintosh, go to the "Signing in to meetingmaker on a Macintosh" section on page 32.
To install meetingmaker using Easy Install:
1. Insert the meetingmaker Software CD into the CD-ROM drive.
2. Double-click the Installer icon located in the meetingmaker Client folder in the Mac folder on the CD.
3. Click Continue.
4. Click Install. Installation begins. The meetingmaker installation does the following:
   • Creates a meetingmaker folder in the Applications folder of the startup disk containing the meetingmaker application, the time zones database, and the meetingmaker Readme file.
   • Installs new print layouts and personal organizer export drivers in the meetingmaker folder in the Preferences folder.

Note: If you have the Palm desktop software installed on your Macintosh, the installer will display a dialog box informing you of Palm OS Platform specific information.

To install meetingmaker using Custom Install:
1. Insert the meetingmaker Software CD into the CD-ROM drive.
2. Double-click the Installer icon located in the meetingmaker Client folder in the Mac folder on the CD.
3. Click Continue.
4. Select Custom Install from the drop-down menu in the upper left corner (it defaults to Easy Install).
5. Select the desired items to install.
6. Choose an install location from the **Install Location** drop-down menu.

7. Click **Install** to begin the installation.

   **Note:** If you have the Palm desktop software installed on your Macintosh and you selected the meetingmaker Palm Conduits as part of the custom install, the installer will display a dialog box informing you of Palm OS Platform specific information.

8. When notified that installation is complete, choose whether you want to create a desktop alias to the meetingmaker Client and if you want to launch the meetingmaker Client. Click **OK**.

### Installing meetingmaker for the Macintosh from a File Server

You can also install meetingmaker on your Macintosh from a network file server using either the Easy or Custom Install option.

- **To install meetingmaker from a file server using Easy Install:**
  1. Use the **Chooser** to mount the file server containing the meetingmaker Client folder.
  2. Locate and double-click the **Installer** icon.
  3. Continue with Step 3 in the section above titled: **To install meetingmaker using Easy Install:** under **Installing meetingmaker for the Macintosh from a CD**.

- **To install meetingmaker from a file server using Custom Install:**
  1. Use the **Chooser** to mount the file server with the meetingmaker Client folder.
  2. Locate and double-click the **Installer** icon.
  3. Continue with Step 3 in the section above titled: **To install meetingmaker using Custom Install:** under **Installing meetingmaker for the Macintosh from a CD**.

### Signing in to meetingmaker on a Macintosh

Once meetingmaker is installed, you can sign in and begin scheduling meetings with people on your network.
 CHAPTER 1: Getting Started

❖ To sign in to meetingmaker on a Macintosh:

1. Double-click the meetingmaker icon. The meetingmaker sign-in dialog box displays:

   ![Welcome to Meeting Makers](image)

   - Name: [name]
   - Password: [password]
   - Timezone: USA Pacific
   - Server: "mm7/mac1"

   [Quit] [Work Offline] [Sign In]

2. Click Server in the sign-in dialog box. The Select Server dialog box appears:

   ![Select Server](image)

   - Protocol: [TCP]
   - Select Zone: Network Wide
   - Select Server: Meeting Maker 7 mm7/mac1

   [Configure...][Cancel][Select]

3. Enter your sign-in name and password. If you don’t know your sign-in name, ask your meetingmaker administrator.

   Note: Your sign-in name may appear in the box. If another name appears, delete it and enter your sign-in name.

4. Select the correct protocol.

   Note: Your meetingmaker administrator can tell you which protocol to choose.

5. Click the Configure button. The Configure IP dialog box displays.

6. Enter the DNS host or the meetingmaker Server’s IP address.

   Note: Your meetingmaker administrator can give you the DNS host or IP address to enter here.

7. Click OK.

8. Select the Server name and click Select.
Note: Your meetingmaker administrator can tell you which server to choose.

9. Click the time zone Select button in the sign-in dialog box. The Select a Time Zone dialog box displays.

   This is your "display" time zone. When you select a display time zone, meetingmaker shows your calendar in the time zone you select. Normally, you should select the time zone in which you live, or spend the majority of your work hours. However, when traveling in a different time zone, for example, you may wish to see your calendar in local time. In this case, select the time zone in which you are traveling.

   Note: For more information on display time zones, see “Changing your Display Time Zone” on page 49.

10. Select your time zone and then click OK.

11. Click Sign In.
Getting Started with meetingmaker for Solaris

To begin using meetingmaker on a Solaris workstation, follow these steps:

- Check hardware and software requirements.
- Install meetingmaker Client software.
- Sign in to meetingmaker.

### Solaris Hardware and Software Requirements

<table>
<thead>
<tr>
<th>Hardware/Software</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>SUN SPARC systems, or Solaris</td>
</tr>
<tr>
<td>OS</td>
<td>Solaris 2.6 or newer - X11R5/Motif 1.2 or OpenWindows 3.0</td>
</tr>
<tr>
<td>Ram</td>
<td>8 MB of RAM</td>
</tr>
<tr>
<td>Disk</td>
<td>10 MB of disk space</td>
</tr>
<tr>
<td>Network</td>
<td>10/100 megabit Network Interface Card, TCP/IP.</td>
</tr>
</tbody>
</table>

### meetingmaker in the Solaris Environment

meetingmaker for Solaris relies on the following environment variables for operation:

- **MMHOME** is the directory in which the meetingmaker Solaris system files are installed.
- **XPPATH** is the directory (usually \$(MMHOME)/xprinter) that points to the printing configuration files.
- **HOME** is a standard Solaris environment variable that meetingmaker uses to place specific files on your machine.

meetingmaker for Solaris creates files in the following locations:
/tmp is where temporary files are placed.

/mmclient below the $HOME environment variable. This directory contains important user data.

**Installing meetingmaker Client Software for Solaris**

**To install meetingmaker Client software for Solaris:**

1. Log in as superuser.

2. Create a directory for the meetingmaker executable. To create and go to a directory called /usr/mm type the following:
   ```
   cd /usr <Enter>
   mkdir mm <Enter>
   cd mm <Enter>
   ```
   Note: If the variables MMHOME or XPPATH are set, then reset them to nothing (blank space).

3. Mount the CD-ROM if it is not already attached.

4. Run the install script by typing the following:
   ```
   ./mminstall <Enter>
   ```
   The mminstall script does the following:
   - verifies where to install
   - verifies the operating system
   - installs x-specific resource files
   - installs printer configuration files
   - prompts you to create a link to /usr/local/bin or other executable directories if desired

5. Set variable MMHOME to the installed directory.

6. Set variable XPPATH to MMHOME_directory/xprinter for all users requiring printing capability.

**Signing in to meetingmaker on Solaris**

Once meetingmaker launches, you can sign in and begin scheduling meetings with people on your network.
To sign in to meetingmaker for Solaris:

1. Launch meetingmaker by typing `./mmxp`. The Sign-In dialog box displays.

2. Enter your sign-in name and password in the sign-in dialog box. If you don’t know your sign-in name, ask your meetingmaker administrator.
   
   Note: Your sign in name may appear in the box. If another name appears, delete it and enter your sign-in name.

3. Click the Server **Select** button. The Select Server dialog box displays.

4. Click **Configure**. The Configure IP dialog box displays.

5. Enter the DNS host or the meetingmaker Server’s IP address.
   
   Note: Your meetingmaker administrator can give you the DNS host or IP address to enter here.

6. Click **OK**.

7. Select a Server and click **Select**.
   
   Note: Your meetingmaker administrator can tell you which server to choose.

8. Click the time zone **Select** button in the sign-in dialog box. The Select a Time Zone dialog box displays.

   This is your "display" time zone. When you select a display time zone, meetingmaker shows your calendar in the time zone you select. Normally, you should select the time zone in which you live, or spend the majority of your work hours. However, when traveling in a different time zone, for example, you may wish to see your calendar in local time. In this case, select the time zone in which you are traveling.
   
   Note: For more information on display time zones, see “Changing your Display Time Zone” on page 49.

9. Select your time zone and then click **OK**.

10. Click **Sign In**.
Passwords

Your meetingmaker administrator may have assigned you a password prior to your initial sign-in, if so obtain the password from him or her. If not, add a password as follows:

❖ To add a password:

1. Select Preferences from the Edit menu.
2. Click Password.
3. Type a password in the New box. (Leave the Current box blank.)
4. Enter the password again in the Verify box.
5. Click OK.

Exiting and Signing Out of meetingmaker

❖ To exit the meetingmaker Client:

1. Choose Exit from the File menu. This signs you out and closes the meetingmaker Client.

Use the Sign Out command to close the connection between your Client account and the rest of the meetingmaker environment without closing the meetingmaker Client. Signing out prevents notifications or reminders from appearing until your next sign-in. Signing out prevents other people from viewing your calendar if you are away from your computer and makes it possible for another user to sign in.

❖ To sign out of meetingmaker:

1. Choose Sign Out from the File menu. The Sign In dialog box displays. To sign back in, enter your password and click Sign In.

Note: If, after signing out you decide to close the meetingmaker Client, click Quit on the Sign In dialog box or close the Sign In dialog box.
CHAPTER 2

Quick Start Tutorial

After installing meetingmaker, sign in and try this Quick Start Tutorial. The tutorial explains how to perform the most common meetingmaker tasks.

Topics include:

- Proposing a meeting
- Scheduling an activity
- Creating a To-Do item
- Responding to a meeting proposal
- Responding to a To-Do proposal
- Assigning a proxy
- Acting as a proxy
Proposing a Meeting

From the File menu choose Propose Meeting.

Enter a meeting title and location.

Click Guests and select names of people to invite to the meeting. You can also choose a meeting room as well as resources, such as a projector, you'll need.

Click Schedule and pick a time that all your guests can attend, or click Auto-Pick to find the first time that all guests are available.

Click Agenda (optional), and enter an agenda, or click Open to insert the text from a document created in another application.

Click Options (optional) to specify reminder or labeling options for the meeting. (These settings appear on your calendar only.)

Click Send Proposal to send out meeting invitations.
Scheduling an Activity

From the File menu choose New Activity, or drag a box on your calendar to indicate an activity time.

Enter a title or brief description of the activity.

Specify an activity date, time, and duration.

For recurring activities, click Frequency and select the appropriate options. Click Ongoing or pick an end date.

Click Notes to add any additional comments about the activity.

Click Options to specify a reminder or activity label.

Click Private to keep your proxies from viewing the activity.

Click Create Activity to place the activity on your calendar.

To change the activity to a meeting, click Invite Guests. meetingmaker changes the activity to a meeting proposal that can include other people.
Creating a To-Do Item

From the View menu choose To-Do List.

Click New to create a new to-do item.

Enter a title for the item.

Assign a date to the to-do item (optional). Set a Priority for the item, and assign a Category, such as Business or Personal.

Use the Notes field to add more information about the item.

To make this a group to-do item, click Participants and specify people to send the to-do item to.

Click Reminder to set a time to be reminded of the item.

Click Create. meetingmaker adds the to-do item to your list.

Click Private to keep your proxies from viewing the item. Enter a Percent Done to track your progress, or click Done to mark a to-do as completed.
CHAPTER 2: Quick Start Tutorial

Responding to a Meeting Proposal

Choose Proposals from the View menu to see a list of new meeting proposals.

From the Active Proposals folder, double-click the new proposal to read the invitation.

Click Guests, Schedule, or Agenda to see meeting details. Click Comments to send a message back with your reply.

To accept the invitation, click Yes, then click Reply. Or, in the Proposals window, simply click Accept. To decline the invitation, or to decide later, click the appropriate button and click Reply.

Responding to a To-Do Proposal

From the To-Do Proposals folder in the Proposals window, double-click the to-do proposal to open it.

Click Participants to see other people who received the proposal.

Click Comments to send a message back with your reply.

Click one of the reply options, then click Reply.

You can set your own priority for group to-do items you receive, and you can mark them private, but you cannot change the title, the date, or notes entered by the proposer.
Assigning a Proxy

A proxy is someone with access to your calendar. Proxies can keep track of meetings and activities, and they can print your calendar for you.

You can designate specific activities and to-do items as private to keep your proxy from viewing them. You cannot designate scheduled meetings as private.

From the Edit menu choose Proxy List.

Select the users you want as proxies and click Read/Write or Read-Only. A Read/Write proxy can change your calendar; a Read-Only proxy can only view your calendar.

Click OK to authorize the selected users as proxies.

Acting as a Proxy

To access the calendar of someone who has designated you as their proxy, choose their name from the Proxy menu. To return to your own calendar, choose your name from the Proxy menu.
CHAPTER 3

meetingmaker Basics

This chapter introduces the basics of using meetingmaker, such as viewing your calendar in different ways and customizing your calendar.

Topics include:
- Daily Calendar
- Monthly Calendar
- Searching Your calendar
- Master Schedule
- Master Schedule Uses
- Using the Navigator
- Using Preferences
- User Info
Daily Calendar

The Daily Calendar displays your scheduled meetings, activities and banners.

Starting meetingmaker for the first time opens the Daily Calendar. Five days are displayed with the current date at the left.

❖ To open the daily calendar if it is not displayed:
1. From the View menu, choose Daily Calendar.

Using the Daily Calendar

Normal work hours are green and non-work hours are gray. Initially, your meetingmaker administrator defines normal work hours and days. You can change them by selecting User Info from the Edit menu. (See “User Info” on page 76 for more information.) You can also change the number of days displayed on your Daily Calendar (up to 14, with or without non-work days) from the Calendar tab on the Edit>Preferences dialog box.

When viewing only normal work days, non-work days are hidden. meetingmaker displays a gray bar where the hidden dates would appear. A red line on the gray bar indicates if there are any events on those hidden days.
The time of day is shown on the calendar as a light blue 15 minute bar in the time column and on both borders of the current day. This makes it easy to see the current time when you view or schedule activities or meetings.

The day and date are displayed at the top of each day column. You can choose to display the week number (of the year) from the Calendar tab on the Edit>Preferences dialog box.

If conflicting meetings or activities are scheduled, you can view the conflicting items side by side rather than overlapping. A red bar indicating the overlap time displays on the left border of the day in which the conflict occurs in both display modes. See Viewing Hidden Events on the Daily Calendar for more information.
Daily Calendar Shortcuts

You can use these shortcuts from the daily calendar:

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>To propose a meeting</td>
<td>Ctrl-drag (Option-drag on Macintosh) over the time to schedule the meeting.</td>
</tr>
<tr>
<td>To schedule an activity</td>
<td>Drag over the time you want to schedule the activity.</td>
</tr>
<tr>
<td>To open a meeting or activity</td>
<td>Double-click the meeting or activity.</td>
</tr>
<tr>
<td>To move a meeting or activity</td>
<td>Drag the event block to the new time or date.</td>
</tr>
<tr>
<td>To copy a meeting or activity</td>
<td>Ctrl-drag (Option-drag on Macintosh) the event block to the new time or date.</td>
</tr>
<tr>
<td>To switch between work days and all days</td>
<td>Click the bar at the top of the calendar between any two days.</td>
</tr>
</tbody>
</table>

Daily Calendar Symbols

The following symbols appear on meeting or activity blocks on the daily calendar:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️</td>
<td>Activity</td>
</tr>
<tr>
<td>✔️</td>
<td>Confirmed meeting. All required guests can attend.</td>
</tr>
<tr>
<td>no symbol</td>
<td>Proposed meeting. Some required guests have not yet responded, but none have said No.</td>
</tr>
<tr>
<td>❌</td>
<td>One or more required guests has declined your invitation.</td>
</tr>
</tbody>
</table>
CHAPTER 3: meetingmaker Basics

Changing your Display Time Zone

In meetingmaker, there are two time zone settings you can adjust: “display” time zone and “work hour” time zone. Your display time zone is the time zone in which your calendar appears. Your work hour time zone is the time zone meetingmaker uses to calculate your availability for meetings. These two time zone settings do not have to be the same. For example, when you are traveling, you may want to change the display time zone, so you can view your calendar events in local time.

When you change your display time zone, events currently on your calendar are shown in the time zone you select. For example, if you live in US Eastern Time and have a conference call scheduled on your calendar for 11:00 AM, when you display your calendar in US Pacific Time, this conference call appears on your calendar at 8:00 AM. This ensures that you won’t miss important meetings and activities, even when traveling in different time zones.

When you change your display time zone, your work hours on your calendar show when you are normally available according to your work hour time zone. For example, if you live in US Eastern Time and have work hours from 9:00 AM to 5:00 PM, when you display your calendar in US Pacific Time, your work hours appear on your calendar from 12:00 PM to 8:00 PM. This ensures that you, as well as other meetingmaker users, schedule meetings and activities according to your normal work hours and time zone, rather than the time zone in which you are traveling.

WARNING: You should not change your work hour time zone unless you are permanently relocating to a different time zone. For more information on changing your work hour time zone, see “Changing your Work Hour Time Zone” on page 77.
To change your display time zone:

1. From the Edit menu, select **Time Zone**.

   **Tip:** You can also change your display time zone in your user preferences. From the Edit menu, select Preferences, then click the Locale tab.

   The Select a Time Zone dialog box appears.

   ![Select a Time Zone dialog box](image)

   - **Country/Region:** USA
   - **Time Zone:** Pacific Time (US & Canada)
   - **Offset from GMT:** 9.0 hours
   - **DST Start Date Rule:** First Sunday in April at 2 AM
   - **DST End Date Rule:** Last Sunday in October at 2 AM
   - **Daylight Savings Start:** Sunday, April 1, 2001 at 2 AM
   - **Daylight Savings End:** Sunday, October 28th, 2001 at 2 AM

   This Time Zone database uses the ICAO standard approved by the IETF.

2. Select the time zone in which you want to display your calendar, and click OK.

   meetingmaker displays your calendar in the time zone you selected.

### Viewing Hidden Events on the Daily Calendar

Hidden events are meetings or activities scheduled beyond the hours currently displayed on your daily calendar. A red bar (black on non-color monitors) indicates hidden events. For example, if your calendar normally displays 9 am to 5 pm, Monday through Friday, and you have scheduled an appointment on Thursday evening at 8 pm, the hidden event bar appears at the bottom of the Thursday column. If the appointment is at 8 am, the bar appears at the top of the Thursday column. If the appointment falls on the weekend, the bar appears in the “day” row between Friday and Monday.
If you schedule conflicting events (more than one meeting or activity at the same time), meetingmaker displays a conflict bar (red on a color monitor) in the column to the left of the conflict. There are two ways to display conflicting events: overlapping and split.

- **To view conflicting events in overlap display mode:**
  1. Click the conflict bar to cycle through each of the meetings and activities scheduled for that time.

- **To display conflicting events in split display mode:**
  1. Choose **Preferences** from the Edit menu. The Preferences dialog box displays.
  2. Click the **Calendar** tab. The Calendar Preferences panel displays.
  3. Select **Split Overlapped Items**, and then click **OK**.

Conflict events are now displayed side by side with a red time bar indicating the overlap duration.

**Labels**

Users can color-code meetings, events, and banners for easy identification. meetingmaker provides 15 color-coded labels for categorizing meetings and activities.

- **To apply a label to an existing meeting or activity:**
  1. Select the meeting or activity on the daily or monthly calendar.
  2. From the Label menu, choose the desired label.

See “Changing Labels Preferences” on page 69 for information about customizing labels.

**Monthly Calendar**

Use the Monthly Calendar for an overview of your schedule for an entire month. Meetings and activities are listed on the days they occur. If a day is blank, there are no scheduled activities or meetings.

- **To open the monthly calendar:**
  1. From the View menu choose **Monthly Calendar**:
When viewing only work days, meetingmaker displays a bar where the hidden dates would appear. If meetings or activities are scheduled on hidden dates, the bar is red (black on non-color monitors).

If there are already activities or meetings on a day, double-click an empty area of the day block to add a new meeting or activity.

**Monthly Calendar Shortcuts**

The following shortcuts are available from the monthly calendar:

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>To view a different month or year</td>
<td>Select <strong>Go to Day</strong> from the View menu or click the month or year indicators.</td>
</tr>
<tr>
<td>To switch between viewing work days and all days</td>
<td>Click the name of any day at the top of each column.</td>
</tr>
<tr>
<td>To view a day in more detail in the daily calendar</td>
<td>Click a date number to display the daily calendar with that day in the left-most column.</td>
</tr>
<tr>
<td>To view details for a meeting or activity</td>
<td>Double-click the meeting or activity.</td>
</tr>
<tr>
<td>To move a meeting or activity</td>
<td>Drag the meeting or activity to a new day.</td>
</tr>
<tr>
<td>To propose a meeting</td>
<td>Ctrl-double-click (Option-double-click on the Macintosh) the desired date for the meeting.</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>To schedule an activity</td>
<td>Double-click the desired day for the activity.</td>
</tr>
<tr>
<td>To copy a meeting or activity to a different day</td>
<td>Ctrl-drag (Option-drag on the Macintosh) the event to a new day.</td>
</tr>
<tr>
<td>To delete a meeting or activity</td>
<td>Select the meeting or activity and press the Delete/Backspace key.</td>
</tr>
</tbody>
</table>
Searching Your Calendar

You can search your calendar for specific text. meetingmaker will then display each occurrence of that text.

To find specific text in your calendar:

1. Select Find from the View menu. The Find dialog box displays:

2. Enter the text you want to find in the Search for box.

3. Select the starting date for the search (you can search forward or backward). To change the search start date, click on a date portion and either use the arrows that appear, or type in a new value.

4. Click one or more of the Search In options. The following options are available:
   - Titles searches meeting and activity titles (but not to-do items).
   - Meeting Agendas searches agendas of proposed meetings and those to which you’ve been invited.
   - Meeting Comments searches for comments you’ve made on meeting invitations and comments others have made regarding your meeting proposals.
   - Activity Notes searches notes attached to activities.

5. Click Find Next to search forward or Find Previous to search backward. meetingmaker highlights the first meeting or activity containing the text you entered.

6. To see additional meetings or activities that include the text you entered, continue to click Find Next or Find Previous.

7. Close the window when finished.
Master Schedule

Master Schedule provides a composite view of busy and free time for a user- or administrator-defined group. You can propose meetings from the Master Schedule that include all members of the defined group. You can perform many of the same tasks from the Master Schedule as you can from your own schedule.

You can perform the following tasks directly from the Master Schedule display:

- Propose group meetings
- Propose meetings for non-proxy users
- Propose meetings for read-only proxy users
- Propose meetings for read/write proxy users
- Schedule activities for read/write proxy users
- View event details for proxy users
- View or change event details for read/write proxy users
- View or change preferences for read/write proxy users

A group must already be created to view the Master Schedule. To create a group, see “Creating Groups” on page 92.

To open a Master Schedule:

1. Select Master Schedule from the View menu. The Pick Group dialog box displays.
2. Click on the desired group name, then click OK. The Master Schedule of that group displays:
3. To close the Master Schedule, select **Close** from the **File** menu.

**Accessing Recently Viewed Master Schedules**

The last five viewed Master Schedules appear at the bottom of the View menu. To quickly access any of these Master Schedules, select the group name from the View menu.
# Viewing the Master Schedule

The following are the components of the Master Schedule:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left column</td>
<td>The group name, followed by the name of each user and resource in the group.</td>
</tr>
<tr>
<td>Group name schedule bar</td>
<td>Composite availability of the whole group.</td>
</tr>
<tr>
<td>Names in blue text</td>
<td>Users or resources whose calendars you have read-only proxy rights to.</td>
</tr>
<tr>
<td>Names in bold blue text</td>
<td>Users or resources whose calendars you have read/write proxy rights to.</td>
</tr>
<tr>
<td>Names in black text</td>
<td>Users or resources whose calendars you do not have proxy rights to.</td>
</tr>
<tr>
<td>Time blocked in yellow (or user-defined color)</td>
<td>Indicates that the user or resource has a meeting or activity scheduled in this block of time; busy time.</td>
</tr>
<tr>
<td>Time blocked in green (or user-defined color)</td>
<td>Indicates that the user or resource has this time set as work hours and does not have a meeting or activity scheduled in this block of time; work hours.</td>
</tr>
<tr>
<td>Time blocked in purple (or user-defined color)</td>
<td>Indicates that the user or resource has this time set as non-work hours.</td>
</tr>
<tr>
<td>Update</td>
<td>Updates the Master Schedule calendar.</td>
</tr>
<tr>
<td>Navigator</td>
<td>Select a date to display on the Master Schedule.</td>
</tr>
</tbody>
</table>
Viewing the Master Schedule in a Different Time Zone

You can adjust the Master Schedule display to view the a group’s composite schedule in a time zone you select. This is useful when you are viewing the Master Schedule for users who are located in different time zones. For example, if your home office is in US Eastern Time, and you view the Master Schedule for a group that includes users from US Eastern Time and US Pacific Time, you can display the Master Schedule in US Eastern Time. This displays each user’s availability according to US Eastern Time. A user whose work hours begin at 9:00 AM Pacific Time will appear in the Master Schedule as beginning at 12:00 PM Eastern Time. If you change the Master Schedule display to US Pacific Time, a user whose work hours begin at 9:00 AM Eastern Time will appear in the Master Schedule as beginning at 6:00 AM Pacific Time.

WARNING: When you change the Master Schedule time zone, you are changing the display time zone for your calendar as well. This means that your events on your daily and monthly calendars will appear in the time zone you select. For more information about changing your display time zone, see “Changing your Display Time Zone” on page 49.

❖ To view the Master Schedule in a different time zone:

1. Open the Master Schedule for the group whose composite schedule you want to view.

2. From the Edit menu, select Time Zone.

   Tip: You can also change the display time zone in your user preferences. From the Edit menu, select Preferences, then click the Locale tab.

   The Select a Time Zone dialog box appears.

3. Select the time zone in which you want to display the Master Schedule, and click OK.

   meetingmaker displays your calendar in the time zone you selected.
**Setting Master Schedule Preferences**

Change the Master Schedule’s default colors and display settings using Preferences. See “Changing Master Schedule Preferences” on page 71.

**Using the Master Schedule**

The Master Schedule can be used exactly as if you were using your own schedule. You can propose meetings, schedule activities, add banners, and invite guests using the options from the File menu.

**Master Schedule Shortcuts**

The following shortcuts are available from the Master Schedule:

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>To propose a group meeting</td>
<td>Drag the work hours area of the group row.</td>
</tr>
<tr>
<td>To propose a meeting for a read/write proxied user or resource</td>
<td>Hold down the Ctrl key while dragging the work hours area of that user’s or resource’s row. (Use the Option key for the Macintosh.)</td>
</tr>
<tr>
<td>To propose a meeting for a read-only proxied user or resource</td>
<td>Drag the work hours area of that user’s or resource’s row.</td>
</tr>
<tr>
<td>To propose a meeting for a non-proxied user or resource</td>
<td>Drag the work hours area of that user’s or resource’s row.</td>
</tr>
<tr>
<td>To schedule an activity for a read/write proxied user or resource</td>
<td>Drag the work hours area of that user’s or resource’s row.</td>
</tr>
<tr>
<td>To view activity or meeting details for a proxied user or resource</td>
<td>Double-click the busy time in that user’s or resource’s row.</td>
</tr>
<tr>
<td>To quickly view any user’s or resource’s Daily Calendar</td>
<td>Double-click the user or resource name.</td>
</tr>
<tr>
<td>To change a proxied user’s or resource’s preferences</td>
<td>Double-click the user or resource name. When the Daily Calendar displays, select <strong>Preferences</strong> from the <strong>Edit</strong> menu.</td>
</tr>
</tbody>
</table>
Master Schedule Uses

The following are some suggested ways to use the Master Schedule calendar:

- **View availability of an entire group**
  The Group name schedule bar indicates the free and busy time of the group as a whole.

- **View several resource calendars at one time**
  Create a group that contains the most commonly used resources (for example, locations). Open the Master Schedule of that group to quickly view a specific meeting time.

- **Include a resource in your group**
  Add a resource to a group to quickly view its availability. For example, a group may always need the use of a VCR, so you would include the VCR in the group.

- **View free and busy time of any user or resource**
  Using Master Schedule allows you to view the free and busy time of any meetingmaker user or resource. This way, the availability of users or resources to which you do not have proxy rights are accessible.
Using the Navigator

You can use the Navigator to select a date to display on your calendar, or to enter a date for a date range (for instance, recurring meetings or print ranges).

To use the Navigator to select a date:

1. Select Go to Day from the View menu or click the Navigator icon located in the upper-right corner of the meetingmaker screen. The Calendar Navigator dialog box displays.

2. Click on the month or year and then click the up or down arrow to move the month or year ahead and back.

3. When the desired month and year are displayed, double-click the desired date (or click the date and then click OK).
Using Preferences

You can use the following user preferences to customize meetingmaker features:

- **Login preferences**
  Create new or change existing passwords, and to choose whether to sign in to meetingmaker automatically when you start meetingmaker. You can also choose to have meetingmaker notify you when a Server connection is lost.

- **Notification preferences**
  Define how and when messages or reminders take place.

- **Calendar preferences**
  Control the appearance of your daily and monthly calendars.

- **Labels preferences**
  Create customized labels to color-code various types of meetings and activities.

- **To-Do preferences**
  Specify new priority categories for your To-Do List.

- **Master Schedule preferences**
  Specify number of days to view and how often to update the view with new information.

- **General preferences**
  Specify how user lists appear, e-mail (SMTP host) settings and message latency.

- **Locale preferences**
  Specify your display time zone; events on your calendar appear in the time zone you select.

Most preferences are associated with your user name and remain active regardless of what workstation on which you sign in. Calendar preferences, however, are workstation-specific and not associated with a username.
CHAPTER 3: meetingmaker Basics

Changing Your Login Preferences

To keep unauthorized people from viewing your calendar, you should create a password.

To create or change your password:

1. Select Preferences from the Edit menu, and then click Login. The Login Preferences panel displays:

2. Enter your current password in the Current field. If you do not have a password, leave this box blank.

3. In the New box, type a password of up to 31 characters.
   Note: meetingmaker passwords are case-sensitive. When signing in to meetingmaker, your password must be entered exactly as created.

4. Retype the new password in the Verify box.
   Note: You can select Remember Password/Sign In Automatically to skip the sign-in process and start meetingmaker automatically when you start your workstation. You will not be prompted for your log in name or password.

5. Select Notify When Connection to Server is Lost if you want meetingmaker to warn you when the Server network connection is lost.
6. Click **OK** to save the settings.
CHAPTER 3: meetingmaker Basics

Changing Notification Preferences

Notification preferences let you specify if, when, and how you receive notifications such as meeting reminders, proposal notifications, and instant messages.

❖ To change Notification preferences:

1. Select Preferences from the Edit menu, and then click Notification. The Notification panel displays:

2. Select one or more of the notification methods below for proposals. These preferences affect how you are alerted when a proposal arrives in your Proposals window.

   • **Blink Icon**
     Shows the notification icon on your desktop.

   • **Bring Proposals Window to Front**
     Notifies you of incoming proposals by showing the Proposals window in front of other meetingmaker windows.

   • **Play sound**
     Notifies you of incoming proposals by playing a sound.

   • **Bring meetingmaker to Front**
Using Preferences

Notifies you of incoming proposals by showing the meetingmaker Client in front of other open application windows.

- **Send Email**
  Notifies you of incoming proposals by sending email to an address you specify. This address can be your regular email address or a pager or wireless phone text messaging address.

- **Restrict Email Times**
  Specifies allowed times for the Send Email notification. For example, if you are sending email to a pager, you can restrict email notification to your work hours.

3. Select one or more of the following notification methods below for messages. These preferences affect how you are alerted when a message, such as a meeting reminder or instant message, arrives in your Messages window.

- **Blink Icon**
  Shows the notification icon on your desktop.

- **Bring Proposals Window to Front**
  Notifies you of incoming messages by showing the Proposals window in front of other meetingmaker windows.

- **Play sound**
  Notifies you of incoming messages by playing a sound.

- **Bring meetingmaker to Front**
  Notifies you of incoming messages by showing the meetingmaker Client in front of other open application windows.

- **Send Email**
  Notifies you of incoming event reminders by sending email to an address you specify. This address can be your regular email address or a pager or wireless phone text messaging address. meetingmaker sends you email only for event reminders, not for instant messages or other messages.

- **Restrict Email Times**
  Specifies allowed times for the Send Email notification. For example, if you are sending email to a pager, you can restrict email notification to your work hours.
4. Indicate when you want meeting/activity reminders.

   Note: meetingmaker must be running minimized to receive notifications when you are not using meetingmaker.

5. Click **OK** to save the settings.

   Note: Proposal notifications alert you that you have received a new invitation or changes about a meeting. Message notifications alert you that it is almost time for an activity or meeting. You may want to set different preferences for proposals and messages. For example, you may want the Messages Window to move to the front when it is time for a meeting but not for an incoming meeting invitation.

### Changing Calendar Preferences

Calendar preferences customize the appearance of your daily and monthly calendar.

- **To change Calendar preferences:**

  1. Select **Preferences** from the Edit menu, and then click **Calendar**. The Calendar panel displays:

        ![Calendar Preferences Panel](image)

        2. Choose the number of hours and days to display on your daily and monthly calendars.
3. Select **Word days only** to make both the daily and monthly calendars only display work days. A red bar appears on the top of the calendar, click the red bar to re-display weekends.

4. Select **Twice normal size** to display your calendar in zoomed mode.

5. Select **Show Week Number** to display the week of the year number.

6. Activate or de-activate **Split Overlapped Items** display mode.

7. Change the **Font** and **Size**, if desired.

8. Move Banners to be displayed below the daily calendar, if desired. The default is to display banners above the daily calendar.

9. Click **OK** to save the settings.
CHAPTER 3: meetingmaker Basics

Changing Labels Preferences

Color monitor users can set 15 custom labels for color-coding daily and monthly calendar events. For example, you can label staff meetings one color and personal activities another color.

❖ To create customized labels:

1. Select **Preferences** from the Edit menu, and then click **Labels**. The Labels panel displays:

2. Enter a label name next to the desired label.

3. To select a new color, click the color square for that label, and then select a color from the color palette.

4. To create a text color for the label, click the letter for that label, and then select a color from the color palette.

5. Click **OK** to save the settings.
Changing To-Do Preferences

You can establish seven custom priority labels, and fifteen custom category labels, for to-do items. These priority and category labels are shown on the To-Do List.

❖ To create customized priorities or categories:
1. Select Preferences from the Edit menu, and then click To-Do. The To-Do panel displays:

2. Enter the new priority or category labels for your to-do items.
3. Click OK to save the settings. The new priorities and categories are now available for your to-do items.
Changing Master Schedule Preferences

You can change the number of days to display and set how often the display updates and change the default colors.

To change Master Schedule preferences:

1. Select Preferences from the Edit menu, and then click M. Schedule. The Master Schedule panel displays.

2. Use the arrows in the Show day(s) box to select the number of days displayed in your Master Schedule window.

3. Select an update interval. The default updates the Master Schedule once every 60 minutes.

4. Select Initiate proxies on opening view to start a background download of proxied users' databases. This eliminates waiting for them to load when you set up activities from the Master Schedule window. The default is off (unchecked).

5. Click in any color block in the Color Scheme portion of the panel. A (platform-specific) color palette appears.

6. Select new colors from the color palette as desired.

7. Click OK to save the settings.
Using Preferences

Changing General Preferences

Use General Preferences to specify how user lists appear, e-mail (SMTP host) settings and message latency.

To change General preferences:

1. Select Preferences from the Edit menu, and then click General.
   The General panel displays:

2. Select Include QuickList users in Contact List to include your QuickList names in your Contact List.

3. Select Show last name first to display last names first in all user lists.

4. Use comma to separate names displays a comma between last and first names in all user lists.

5. Specify when meetingmaker deletes messages by selecting your Message Latency options.
   - Auto-accept during free time allows meetingmaker to accept proposals if you have no other events scheduled for the proposed time. If the meeting is outside of regular work hours or if it conflicts with an event on your calendar, auto-accept does not accept the meeting; you must accept the meeting manually.
   - Delete proposals after X days discards proposals after they
age the specified number of days.

6. In the E-Mail Settings area, enter your **Local SMTP Host** address, **E-Mail Address**, and **E-Notify Address**. This information enables meetingmaker to send meeting information to people outside of your organization via e-mail.

   In the **Local SMTP Host** field, enter the address of your mail server. Your network administrator can tell you the address to enter here.

   In the **E-Mail Address** field, enter your email address. meetingmaker uses this as your "reply to" address when you send external meeting proposals.

   In the **E-Notify Address** field, enter the address you want to use to send proposals and messages to your wireless device, e.g., your pager or wireless phone. If you are unsure, ask your network administrator which address to enter here.
Changing Locale Preferences

In meetingmaker, there are two time zone settings you can adjust: “display” time zone and “work hour” time zone. Your display time zone is the time zone in which your calendar appears. Your work hour time zone is the time zone meetingmaker uses to calculate your availability for meetings. These two time zone settings do not have to be the same. For example, when you are traveling, you may want to change the display time zone, so you can view your calendar events in local time.

You can change your display time zone from the Locale tab on the Preferences dialog box. When you change your display time zone, events currently on your calendar are shown in the time zone you select. For example, if you live in US Eastern Time and have a conference call scheduled on your calendar for 11:00 AM, when you display your calendar in US Pacific Time, this conference call appears on your calendar at 8:00 AM. This ensures that you won’t miss important meetings and activities, even when traveling in different time zones.

When you change your display time zone, your work hours on your calendar show when you are normally available according to your work hour time zone. For example, if you live in US Eastern Time and have work hours from 9:00 AM to 5:00 PM, when you display your calendar in US Pacific Time, your work hours appear on your calendar from 12:00 PM to 8:00 PM. This ensures that you, as well as other meetingmaker users, schedule meetings and activities according to your normal work hours and time zone, rather than the time zone in which you are traveling.

WARNING: You should not change your work hour time zone unless you are permanently relocating to a different time zone. For more information on changing your work hour time zone, see “Changing your Work Hour Time Zone” on page 77.

To change Locale preferences:

1. Select Preferences from the Edit menu, and then click Locale.

Tip: You can also change your display time zone from the Edit menu. From the Edit menu, select Time Zone.
CHAPTER 3: meetingmaker Basics

The Locale panel displays:

2. Click Select.
   The Select a Time Zone dialog box appears.

3. Select the time zone in which you want to display your calendar, and click OK.
   meetingmaker displays your calendar in the time zone you selected.
Use the User Info screen to specify your normal work days and hours, your phone number, and additional information. You can also change your work hour time zone.

**WARNING:** You should not change your work hour time zone unless you are permanently relocating to a different time zone. Before changing your work hour time zone, read .... below

- **To enter/change your work days and hours, phone number, and additional information:**

  1. Select **User Info** from the Edit Menu. The User Info dialog box displays:

     ![User Info Dialog Box](image)

     1. Enter the desired information in the provided fields. Information entered here appears when other meetingmaker users select your name and click **Get Info** in the Meeting Proposal Guests panel.

2. Enter the desired information in the provided fields. Information entered here appears when other meetingmaker users select your name and click **Get Info** in the Meeting Proposal Guests panel.
When you invite external (i.e., non-meetingmaker) guests to a meeting, these guests see and respond to the e-mail address entered on this screen.

3. Select work days and indicate your work hours. You can do the following:
   - Indicate different times for all week days.
   - Change one day at a time.
   - Change many days at a time.
4. Click OK to save the User Info settings.

**Changing your Work Hour Time Zone**

In meetingmaker, there are two time zone settings you can adjust: “display” time zone and “work hour” time zone. Your display time zone is the time zone in which your calendar appears. Your work hour time zone is the time zone meetingmaker uses to calculate your availability for meetings. These two time zone settings do not have to be the same. For example, when you are traveling, you may want to change the display time zone, so you can view your calendar events in local time.

**WARNING:** You should not change your work hour time zone unless you are permanently relocating to a different time zone. Before changing your work hour time zone, read the information on work hour time zones below. If you wish to view your calendar in a different time zone, for example when traveling, change your display time zone only. For more information on changing your display time zone, see “Changing your Display Time Zone” on page 49.

meetingmaker uses your work hour time zone, rather than your display time zone, to determine your availability for meetings. When users in different work hour time zones schedule a meeting together, meetingmaker uses the work hour time zone to check availability and schedule the meeting for each user at the correct local time. For example, if you live in US Eastern Time and schedule a conference call for 11:00 AM with a colleague who lives in US Pacific Time, meetingmaker automatically proposes the meeting for 8:00 AM Pacific Time for your Pacific-based colleague. Therefore, it is important that
you set your work hour time zone to the time zone in which you reside, or in which you spend the majority of your work hours. This allows meetingmaker to accurately calculate meetings among users in different work hour time zones.

You should change your work hour time zone only when you are permanently relocating to a different time zone. Thus, when you change your work hour time zone, you should change your display time zone to match. To learn how to change your display time zone, see “Changing your Display Time Zone” on page 49. When you change both your work hour and display time zones, meetingmaker converts all events on your calendar to the time zone you select, and uses the new work hour time zone to determine your availability for all meetings. For example, if you live in US Eastern Time and have a conference call scheduled on your calendar for 1:00 PM, when you change your work hours and display to US Pacific Time, this conference call is converted to 10:00 AM. In addition, if you have work hours from 9:00 AM to 5:00 PM US Eastern Time, when you change your work hours and display to US Pacific Time, your work hours are converted to 9:00 AM to 5:00 PM Pacific Time. meetingmaker now uses US Pacific Time to check your availability for all meetings.

WARNING: If you change your work hour time zone, you should change your display time zone to match. However, if you change your display time zone, for example when traveling, you should not need to change your work hour time zone to match. For more information on display time zones, see “Changing your Display Time Zone” on page 49.
This chapter describes how to propose and schedule meetings, including how to invite guests and how to create contacts.

Topics include:

- Proposing meetings
- Creating contacts for your guest lists
- Using your QuickList
- Finding a meeting time
- Proposing a meeting while working offline
- Monitoring meeting responses
- Changing a scheduled meeting
- Meeting notification
- Responding to meeting proposals
- Public and personal groups
- Scheduling resources
Proposing Meetings

To propose a meeting in meetingmaker, you must do the following:

- Start the proposal by specifying the title and location.
- Select the guests you want to attend the meeting.
- Choose a meeting time.
- Define the agenda (optional).
- Define reminder and label options (optional).
- Send the proposal.

To propose a meeting and specify the topic and location:

1. Select Propose Meeting from the File menu. The Meeting Proposal window displays:

![Meeting Proposal window](image)

Note: You can also start a meeting proposal by opening an activity, and then clicking the Invite Guests button.

2. Enter a meeting title in the Title box.

3. Enter a meeting location in the Location box. If you enter a location here, the location will not be reserved or booked. If you want to reserve a room automatically through meetingmaker, skip this step and choose the location during guest selection. See “Scheduling Resources” on page 106 for more information.
Selecting Guests

Click the **Guests** tab on the Meeting Proposal Screen to invite guests to a meeting. A Select Guest panel displays. This is where you will select the guests for the meeting. Directly above the Select Guest panel is a drop-down window containing four separate lists you can navigate through in search of attendees for your meeting. These lists include the following:

- **Most Recent Invitees**, which are guests you have most recently invited from this workstation.
- **The QuickList**, which is your own personal address book, including any personal groups you have defined.
- **The Public Directory**, which includes names of all meetingmaker users and resources. This also includes public groups set up by your meetingmaker administrator.
- **Contacts**, people outside of your organization who you have entered in your contact list.

You can select guests from the Guest panel one at a time or collectively. If there is only one guest you want to invite on the list, follow the instructions below.

**Note:** When you propose a meeting, you become a required guest. You can change yourself to another guest type but you cannot remove your name from the list.

Inviting a Guest to a Meeting

Once you have selected a guest list from the Meeting Proposal screen, you can select the individual guest(s) you want to invite to the meeting by following these instructions:

- **To invite a guest to a meeting:**
  1. Click the name of the individual you want to invite to the meeting. The name of the guest will be highlighted.
  2. Select the Guest Type that best describes the status of the guest you are inviting.

A Guest Type identifies the status of the guest. For example, a "required" guest must attend the meeting, whereas a guest with an "optional" status has the choice not to attend.
The following is a description of each guest type:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Guest Type</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄</td>
<td>Required</td>
<td>Essential to the meeting.</td>
</tr>
<tr>
<td>🔄</td>
<td>Optional</td>
<td>Invited but not required.</td>
</tr>
<tr>
<td>🔄</td>
<td>CC</td>
<td>Not invited but gets a copy of the proposal and can choose to display the meeting on their calendar.</td>
</tr>
<tr>
<td>🔄</td>
<td>BCC</td>
<td>Not invited but gets a copy of the meeting proposal. Other guests can not see that this person has been sent a copy of the meeting invitation.</td>
</tr>
<tr>
<td>🔄</td>
<td>Contact with e-mail</td>
<td>Guest receives meetingmaker proposal via e-mail.</td>
</tr>
<tr>
<td>🔄</td>
<td>Contact without e-mail</td>
<td>Guest invited to meeting but will not receive any invitation from meetingmaker.</td>
</tr>
</tbody>
</table>

**Inviting Multiple Guests to a Meeting**

Although you can individually select the names of each guest as one way to invite guests to a meeting, it is not the most efficient way to invite multiple guests on the same list.

**To invite multiple guests:**

1. On the Guest panel, do one of the following:
   
   • Hold down the Shift key while clicking on the name of each guest
   
   or
   
   • Drag the mouse across the name of each guest on the guest list.
CHAPTER 4: meetingmaker Meetings

The names of each guest will be highlighted.

Note: Both selection methods work only if the names of the guests appear consecutively in the Guest Panel.

2. Select the Guest Type that best describes the status of the guests that you are inviting.

A guest type identifies the status of the guest. For example, a "required" guest must attend the meeting, whereas a guest with an "optional" status has the choice not to attend.

The name of each guest will appear dimmed in the original guest list once you add them to your Meetings Guest List.

Searching for a Guest

The Meeting Proposal screen is equipped with a Search feature that you can use to locate various entities, including guests, resources, contacts and locations that you are having trouble finding in the Guest Panel.

You can search for an entity by using the Search feature in one of the following ways:

- Spelling the proper name of the entity.
- Phonetically spelling the name of the entity.
- Partially spelling the name of the entity.

The Search feature can be extremely useful, especially if you are having difficulty in spelling the name of a guest or if the guest list is so large that searching by name would be faster than scrolling through the list.

To search for a guest from the Meeting Proposal screen:

1. Click the Search button. The User/Resource Search screen displays:

![User/Resource Search window](image)
2. Enter the first and last name of the guest you are trying to locate.
   
   Note: It is not necessary that you know the complete or exact spelling of the name.

3. There are two types of search categories:
   
   • Entity types to locate
   
   • Matching options
   
   Click any search category options that will be useful in searching for the entity.

4. Click the **Search** button.

   meetingmaker searches through the guest lists according to the information you provided. Once it locates the guest, the name of the guest will appear in the Guest Panel. At this point, you can either add the guest to your Guest List view additional information about the guest. To view additional guest information, refer to the next section on Additional Guest Information.

### Additional Guest Information

The **Get Info** feature on the Meeting Proposal screen lets you view additional information about a guest that could prove useful when preparing an agenda, updating your business records, or preparing other types of group hand-outs.

Use the Get Info feature to obtain specific guest information such as the guest’s title, department, and company, as well as business address, telephone number, fax number, and e-mail address.

- **To Get Info on a guest from the meetingmaker Proposal screen:**

  1. Click the name of the guest whose additional information you want to view.
2. Click the **Get Info** button. The User Information panel displays:

![User Information Panel]

**Note:** User Information is only displayed if the user or administrator has entered this information.

### Inviting Guests

- **To invite guests to a meeting or activity without adding them to your QuickList:**
  1. Click the pull-down arrow above the QuickList list.
  2. Select **Public Directory**. The Public Directory list appears showing all (administrator-created) public and personal groups locations and other available resources on your meetingmaker Server.
  3. Double-click **All Users**. A list of all meetingmaker users displays.
4. Meetingmaker features full type-ahead guest selection. Begin typing the desired user's last name. When the desired user is highlighted, click one of the following guest types:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Guest Type</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌟</td>
<td>Required</td>
<td>Essential to the meeting.</td>
</tr>
<tr>
<td>🔖</td>
<td>Optional</td>
<td>Invited but not required.</td>
</tr>
<tr>
<td>👥</td>
<td>CC</td>
<td>Not invited but gets a copy of the proposal.</td>
</tr>
<tr>
<td>🔥</td>
<td>BCC</td>
<td>Not invited but gets a copy of the proposal. Other guests are not notified that this person has been sent a copy.</td>
</tr>
</tbody>
</table>

Once selected, guests appear as follows:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌟</td>
<td>Guest has no scheduled meetings or activities at this time.</td>
</tr>
<tr>
<td>🔖</td>
<td>Guest has an activity or another meeting scheduled at this time.</td>
</tr>
<tr>
<td>🔥</td>
<td>Guest status is unknown. Meetingmaker cannot check guest's schedule because the server is unavailable or has not responded yet.</td>
</tr>
<tr>
<td>🔗</td>
<td>The meeting occurs outside of the guest's work hours or on a non-work day.</td>
</tr>
</tbody>
</table>

5. To remove someone from a guest list, select the name on the Guests list in the right scroll box and click **Remove**.
Shortcuts to Selecting Guests

Use the following shortcuts to select guests quickly:

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>To make someone a required guest</td>
<td>Double-click the guest’s name.</td>
</tr>
<tr>
<td>To highlight several users at once</td>
<td>Shift-click each name or shift-click and drag over several names.</td>
</tr>
<tr>
<td>To find and highlight a name quickly</td>
<td>Click in the list, then type the first few letters of the last name.</td>
</tr>
</tbody>
</table>

To display a different user list, choose one of the following options from the menu above the user list:

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>You See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Public Directory</td>
<td>All your personal groups, all public groups, all users, servers, locations, and resources; listed alphabetically</td>
</tr>
<tr>
<td>Contacts</td>
<td>Your list of contacts from outside your organization</td>
</tr>
<tr>
<td>Most Recent Inviteses</td>
<td>Users, locations, and resources that you have recently added to a guest list</td>
</tr>
<tr>
<td>QuickList</td>
<td>You QuickList (address book of meetingmaker users you interact with frequently)</td>
</tr>
</tbody>
</table>
Creating Contacts for Your Guest Lists

The Contact Guest List is one of four available guest lists available on the Meeting Proposal screen. It is your responsibility to create and maintain this list.

❖ To add new contacts to your list:

1. Select View from the Menu Bar, and then select Contact List. The Contact List screen displays.
2. Click the Create button. The Contact Information entry screen displays.
3. Enter the first and last name of the new contact, as well as any other type of business information (e.g., company address, e-mail).
4. Click the OK button.

The Contact List screen displays, showing the new contact information. This is a read-only screen. The name of the new contact will appear next to an icon in a window to the left of the Contact List screen. This is your contact list. Whenever you want to update or delete an existing contact, simply click on the contact name in this window to re-open the Contact Information entry screen.

External Guests and Contacts

Windows users with MAPI-based e-mail and all users with SMTP mail can invite “external” guests (non-meetingmaker users) to meetings via e-mail directly from the Meeting Proposal window. External guests can be anyone you can reach via e-mail.

Instead of a meetingmaker meeting proposal, external guests receive an e-mail message containing the following data from the proposal:

- Subject
- Location
- Time
- Title
- Date
- Guests
- Agenda
Creating External Guests as "Contacts"

Whenever you are adding a new contact to a contact list that is not already part of another guest list, you must be online during or after you create the new contact, so that the Server can assign the new contact a global ID. If you add a new contact without going online, the new contact will not get a global ID, and you will be unable to invite the contact to any meetings.

To create external guests:

1. Select Contact List from the View menu. The Contact List window displays:

2. Click New. The Contact Information dialog box displays:
3. Enter any relevant personal information for the contact. You must enter the contact’s e-mail address for the contact to receive a meetingmaker e-mail invitation. Contacts without e-mail addresses can be added to proposals as a visual reference for other invitees, but such contacts do not receive any form of invitation.

4. Click OK. Add additional contacts as needed.

**Inviting External Guests/Contacts**

❖ **To invite external guests/contacts:**

1. Select **Contacts** from the pull-down menu in the Proposal screen’s “Guests” panel. Available contacts appear in the User list.

2. Add contacts to your proposal’s “Guests” list as you would normal meetingmaker guests. External guests (contacts) receive their meeting invitation via e-mail.

3. Click **Send Proposal** when finished inviting (meetingmaker and/or external “contact”) guests. meetingmaker users receive the proposal in meetingmaker. External guests (contacts) receive their meeting invitation via e-mail.

**Configuring meetingmaker for External Guests/Contacts**

Once you have created external guests as contacts, you must configure meetingmaker in order to send invitations to External Guests via e-mail.

❖ **To configure meetingmaker for external guests/contacts:**

1. Select **Edit** from the Menu Bar, and then select **Preferences**. The Preferences dialog box displays.

2. Click the **General** tab.

3. Enter the Local SMTP Host. This should be a domain name, such as yourcompany.com. Your network administrator can tell you what to enter here.

4. Enter the e-mail address that you want to receive external guest’s replies. Click OK.

5. Continue with the proposal. The e-mail meeting invitation is sent when you click **Send Proposal**.
Editing Contacts

To edit your contacts:

1. Select Contact List from the View menu. The Contact List window displays.
2. Select a contact and then click Open. The Contact Information dialog box displays.
3. Make changes as required.
4. Click OK.

Using Your QuickList

Most meetingmaker users normally propose meetings and activities with only a portion of a company’s meetingmaker users. meetingmaker’s QuickList lets you create a custom address book to store the list of guests you most frequently interact with. You can also create your own personal user groups for recurring meetings and activities.

To add users to your QuickList or to create personal user groups:

1. Select QuickList from the Edit menu. The Edit QuickList window displays:

2. Select Public Directory from the leftmost drop-down menu. The Public Directory list appears showing all (administrator-created) public and personal groups, locations and other available resources on your meetingmaker Server.
3. Double-click All Users from the Public Directory. A list of all meetingmaker users appears.

4. meetingmaker features full type-ahead guest selection. Begin typing the desired user’s last name. When the desired user is highlighted, click Add to add the user to your QuickList.

5. To remove someone from your QuickList, select the name on the QuickList list in the right scroll box and click Remove.

6. Click OK when finished editing the QuickList.

Creating Groups

To create groups for your QuickList:

1. Select QuickList from the Edit menu. The Edit QuickList window displays.


3. Enter a name for the new group in the New Group dialog box.

4. Click Create. The new group is created and appears on the right side of the Edit QuickList window.

5. Double-click the name of the new group to open it.

6. Select the desired users from the left scroll box. Users for the new group can originate in any group or subgroup available in the left scroll box. For example, you can create a group from All Users or your QuickList.

7. Click Add to add selected users to the new group.

8. Click OK when finished. The Edit QuickList window closes. The new group appears in the left scroll box the next time you access the Guests in a Meeting or Activity proposal.

You can use this group for meeting invitation or master schedule views.
CHAPTER 4: meetingmaker Meetings

Finding a Meeting Time

Meetings initially default to the current time on the current day for one hour or the date, time, and duration you select by dragging a box on your calendar. You can not schedule meetings in the past.

The Composite Schedule

The Schedule panel contains a composite of the schedules of all required and optional guests. Use this information to find a date and time when everyone is available. This feature lets you view users’ busy times regardless of proxy right.

❖ To schedule the meeting:

1. Click Schedule. The following symbols next to the usernames show who is available at the specified time:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>✳️</td>
<td>Guest has no scheduled meetings or activities at this time.</td>
</tr>
<tr>
<td>✳️️</td>
<td>Guest has an activity or another meeting scheduled at this time.</td>
</tr>
<tr>
<td>✳️?</td>
<td>Guest status is unknown. meetingmaker cannot check guest’s schedule because the Server is unavailable or has not responded yet.</td>
</tr>
<tr>
<td>✳️️️</td>
<td>Meeting occurs outside of the guest’s work hours or on a non-work day.</td>
</tr>
</tbody>
</table>

2. You can send proposals even if one or more guests have scheduled activities at the chosen time. If one or more guests is unavailable, use one of the following methods to change the meeting time or date:

- Click Auto-Pick to find a meeting time that all required guests can attend.
- Enter a new date, time or duration by typing it in or by using...
Finding a Meeting Time

the arrows to change the settings.

• Drag the meeting to a new time on the composite schedule.
• Drag the lower right corner of the meeting box to change the meeting duration.

The composite schedule panel contains two thin vertical columns, one for required guests and one for optional guests. If any of the guests are busy during that time slot, the time will be blocked off in the appropriate column.

Scheduling Recurring Meetings

❖ To schedule a meeting that occurs on a regular basis:
1. Click Frequency. The Frequency panel displays:

2. Select the meeting frequency (how often you want the meeting to occur). The following table explains the frequencies and their variations:

<table>
<thead>
<tr>
<th>Frequency</th>
<th>Variations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Daily</td>
<td>Every day: every day, including weekends and holidays.</td>
</tr>
<tr>
<td></td>
<td>Every nth day: every n days (includes weekends).</td>
</tr>
<tr>
<td></td>
<td>On these days of the week: each week on selected days.</td>
</tr>
<tr>
<td>Weekly</td>
<td>Every week: once a week on the selected day.</td>
</tr>
</tbody>
</table>
### Frequency Variations

<table>
<thead>
<tr>
<th>Frequency</th>
<th>Variations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Every $n$ weeks:</td>
<td>once each $n$ weeks on the selected day.</td>
</tr>
<tr>
<td>On these weeks of the month:</td>
<td>on days you indicate (e.g., every second Thursday).</td>
</tr>
<tr>
<td>Monthly</td>
<td>Every (other) $nth$: once a month on the selected date, or every other month on the selected date. $nth$ from the end of every (other) month: counts backward from the last day of every (other) month.</td>
</tr>
<tr>
<td>Quarterly</td>
<td>Every three months on the selected dates</td>
</tr>
<tr>
<td>Annually</td>
<td>Once a year on the selected dates</td>
</tr>
</tbody>
</table>

Note: When choosing Monthly, Quarterly, or Annually, you must also specify what to do if the specified date falls on a weekend. You can choose not to move it or you can choose to move it to the previous week day, the next week day, or the closest week day.

3. Enter a meeting end date or click Ongoing. The Start Date reflects the date you chose for the event. You can change that here as well.

Note: meetingmaker checks for future conflicts of recurring meetings. (Same Server, one year; remote Server, one month.)

4. Click **OK** when finished.

### Setting an Agenda

An agenda describing meeting topics can be sent to guests as part of the meeting proposal.

#### To set an agenda:

1. Click the **Agenda** tab in the Meeting Proposal screen.
2. Enter an agenda, or do one of the following:
   - Paste text from an existing document using **Cut**, **Copy**, and **Paste** from the Edit menu.
   - Click **Open** to import a document created in another application and saved as a text file.
Finding a Meeting Time

- Select **Save as** to save the agenda as a text file.

Note: Importing text files into the notes area of the activity window replaces any existing text. Enter additional text after opening the file.

**Specifying Reminder and Label Options**

Specify if and when you receive a reminder notification of the meeting, and whether the meeting is labeled.

Your reminder and label options do not effect guests. When guests receive meeting proposals, they can set their own options.

If you do not change reminder options here for a specific meeting, meetingmaker will use the reminder option you have set in your preferences.

❖ **To set a meeting reminder:**

1. Click **Options** in the Meeting Proposal window. The Options panel displays:

2. Choose when you want to receive the meeting reminder.
To color-code label a meeting:

From the Options panel in the Meeting Proposal window, choose the desired label from the Label menu. Use Preferences to customize these labels for your own use. See “Changing Labels Preferences” on page 69.

Flexible and Private Events

When someone invites you to a meeting that conflicts with an activity on your calendar, you appear busy to the proposer. If you mark the meeting Flexible, the meeting appears on your calendar but you appear available to other users.

Normally, your proxies can view all details of events on your calendar. Marking an activity Private prevents proxies from seeing or printing the title or the details of the event.

- Click Flexible to let other people know that you are available to attend events at the time of this event.
- Click Private to keep proxies from reading an event's description.

Note: Private is not enabled for meetings, only for other events and activities.

Comments

The Comments button is dimmed when you propose a meeting. When guests receive a meeting proposal, they can use the Comments field to send information back to you along with their responses.

Sending the Meeting Proposal

To send the meeting proposal:

1. Click Send Proposal.

2. If one or more required guests has a conflict at the proposed meeting time, an alert box displays. You can send the proposal anyway or modify the proposal to find a more suitable time.

3. If a meeting location is set up as first come/first served, and it is not available, you will not be able to send the meeting proposal.

The meeting automatically appears on your calendar, and meeting invitations are sent to all guests.
Proposing a Meeting While Working Offline

To schedule a meeting while working offline, complete the meeting proposal (as you would if you were connected to the Server). Keep the following in mind when creating meeting proposals offline:

- When the Server is unavailable, the Auto-Pick and composite schedule features cannot see other meetingmaker users. If you need these features to schedule a meeting, you must first login to the Server.
- The proposal is sent automatically when you login to the Server.
- If you can access your e-mail application while offline, you can invite external guests.
CHAPTER 4: meetingmaker Meetings

Monitoring Meeting Responses

Once meeting invitations are sent, you can monitor guest responses in the following ways:

- If all required guests accept your invitation, you get a message saying that all required guests can attend. At that point, the meeting is considered confirmed. A check in the upper left corner of the meeting block on your calendar indicates that the meeting is confirmed.
- If a required guest declines your invitation, you get a message saying that at least one required guest has said No. If a required Location refuses, a different message appears.
- If there are any unread comments associated with a confirmed meeting, a Notes icon appears in the upper right corner of the meeting block on your Daily Calendar.
- If you are a CC or a BCC, meetings you propose do not appear on your daily or monthly calendar. To change or review a proposal, you must refer to the Your Proposals folder in the Proposals window.

❖ To view a guest’s response:

1. Open the meeting proposal.
2. Click **Guests**. The following symbols next to each guest in the guest list indicate the guest’s response:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>Guest accepted invitation.</td>
</tr>
<tr>
<td>☹</td>
<td>Guest declined invitation.</td>
</tr>
<tr>
<td>?</td>
<td>Guest will decide later.</td>
</tr>
<tr>
<td>blank</td>
<td>Guest has not yet replied.</td>
</tr>
</tbody>
</table>

99
To view guests’ comments:
1. Click Comments to see comments that guests have sent you. Guests’ names are underlined if a comment is added or changed.

To check the status of your proposals:
1. Select Messages from the View menu.
The Your Proposals folder lists each meeting you’ve proposed along with one of the following symbols:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>All required guests accepted your invitation.</td>
</tr>
<tr>
<td>❌</td>
<td>At least one required guest declined your invitation.</td>
</tr>
<tr>
<td>❓</td>
<td>Not all required guests have responded, but none have declined.</td>
</tr>
</tbody>
</table>

Changing a Scheduled Meeting

Once a meeting is scheduled, if you change any aspect other than options, meetingmaker notifies your guests. External guests are notified of any time and location changes to scheduled meetings. Normal guests are notified of all meeting changes.

To change a meeting invitation:
1. Select the meeting and then select Open Proposal from the File menu, or double-click the meeting on your calendar.
2. Change the date, time, duration, frequency, guest list, agenda, location or meeting title.
   Note: If you remove someone from the guest list, their name is crossed out. The name is removed completely when you send the proposal.
3. Click Notify Guests.

Consider the following when changing a scheduled meeting:
When changing the date, time, duration, or frequency of a meeting, meetingmaker removes the meeting from your guests’ schedules and notifies all guests. If you change the guest list, agenda, location, or meeting title, meetingmaker notifies all guests. The changed items are underlined in the meeting proposal.

When changing meeting options, the changes appear on your calendar but not on guest calendars. Guests can modify options themselves.

**Changing a Recurring Meeting**

When changing a recurring meeting, you can indicate whether the changes pertain to just the selected meeting, to meetings after a selected date, or to all instances of the recurring meeting.

- **To change a recurring meeting:**
  1. Open the Meeting Proposal for the desired meeting (click it and select **Open Proposal** from the File menu or double-click the meeting).
  2. Change the information and click **Notify Guests**.
  3. In the Change Recurring Meeting dialog box, indicate if the change affects only one meeting, all recurring meetings after a specified date, or all recurring meetings, and then click **OK**.

**Canceling a Scheduled Meeting**

When you cancel a meeting, meetingmaker notifies all guests of the cancellation.

To cancel a meeting, select the desired meeting proposal on your calendar and select **Cancel Meeting** from the Edit menu (or press the Delete/Backspace key).
Meeting Notification

When meetingmaker is running, you are notified of meeting proposals as soon as they are received.

To receive notifications when not using meetingmaker, run meetingmaker minimized.

Responding to Meeting Proposals

You can respond to a proposed meeting by agreeing to attend, declining the invitation, or deferring your decision. External guests cannot respond to meeting invitations.

To respond to a meeting proposal:
1. Select Messages from the View menu.
2. Select the message and click Open (or double-click the message).
3. Click the Guests, Schedule, and Agenda buttons to see information about the proposed meeting.
4. To save the agenda as a text file, click Agenda, then click Save as and type a file name for the agenda.
5. Click Options (optional) to specify a reminder and/or label for this meeting.
6. Click Comments (optional) to add a comment to your response.
Click **Open** to import a text document.

Click **Save as** to save your comments in a text file.

7. To accept, click **Yes**, and then click **Reply**. The proposal window closes and the meeting appears on your calendar.

To decline, click **No**, and then click **Reply**. The invitation moves to the Your Refusals folder in your Proposals window. You can open it and change your reply if you decide to attend.

To postpone your reply, click **I'll decide later**, and then click **Reply**. The proposal window closes, leaving the invitation on your Active Messages list. Your calendar remains unchanged.

**Note:** When a meeting is proposed outside normal work hours, or in conflict with another scheduled event, “No” becomes the default response. You can change the response to “Yes.”

8. Clicking **Reply** sends your response to the meeting proposer.

### Changes to a Planned Meeting

meetingmaker notifies you of any changes in meetings you are scheduled to attend. Icons appear next to messages in your Proposals window indicating notices, cancellations, or rescheduling. See Chapter 6, "Proposals" on page 120 for a key to all icons.

- **To review a changed meeting proposal:**
  1. Select **Proposals** from the View menu.
  2. Select the desired message and click **Open** (or double-click the message). Any changes are underlined.
  3. If the meeting’s location, date, time, duration, or frequency changes, you must accept or decline again.

If the meeting is canceled, you are notified and the meeting is removed from your calendar.

### Changing a Refusal to an Acceptance

After refusing an invitation, you can change the refusal to an acceptance at any time until the meeting occurs. Refused proposals appear in the Your Refusals folder in the Proposals window.
To change a refusal to an acceptance:

1. Select Messages from the View menu.
2. Select the desired message from the Your Refusals folder, and then click Open (or double-click the message).
3. Click Yes, and then click Reply.

meetingmaker notifies the proposer and adds the meeting to your calendar.

Public and Personal Groups

You can divide user lists into smaller, more easily managed units called groups. A group is similar to a distribution list: it is a set of users who can be invited together to meetings. You can invite a whole group or you can display the members of the group and select individual members from it. You can also use groups to view the master schedule. There are two types of meetingmaker groups:

- Public Groups
  Created by the meetingmaker administrator for all meetingmaker users (for example, departments in your company).

- Personal Groups
  Created by you to include individuals you meet with regularly.

To create or edit a personal group:

1. Select QuickList from the Edit menu.
2. Click New Group to add a new group.
3. Enter a group name in the dialog box and click Create.
   The Edit QuickList dialog box displays showing the new group name in the popup menu over the right scroll box.
4. Double-click the name of the new group to display it in the top heading box on the right side.
5. Select users (or groups, resources, Servers or locations) to add to the new group from the left list and click Add. Double-clicking on an item moves it from one list to the other. Select several items at a time by Ctrl-clicking (Shift-clicking on the Macintosh).
Modifying Personal Groups

❖ To add users from another group:

1. From the Edit QuickList dialog box, select the group name from the list on the left and click Open. A list of users in the group appears for you to choose from.

2. Select desired users from the left list and click Add. The selected users are added to the group on the right.

❖ To view additional information about a user:

1. Select the user’s name from the left list and click Get Info.

❖ To rename a personal group:

1. From the Edit QuickList dialog box, select the group to rename from the list on the right.

2. Select the group to rename, and click Rename. The Rename dialog box displays:

   ![Rename Group dialog box]

   3. Enter the new group name and then click Rename.

Removing Personal Groups

When removing personal groups, only the group is deleted. Users are not removed from the Server.

❖ To remove a personal group:

1. From the Edit QuickList dialog box, select the group to remove from the list on the right.

2. Click Remove. A strike-through line appears over the selected group.

3. Click OK to delete the group or Cancel to abort. The selected group is removed from the QuickList.
Scheduling Resources

Use meetingmaker to reserve resources such as meeting rooms and equipment (for example, projectors or VCRs). Your meetingmaker administrator must set up these resources before they are available to users.

Depending on the setup, resources are available on a first-come, first-served basis or through a proxy assigned to them, who must then respond "yes" or "no" to each proposal.

meetingmaker does not normally let users book resources already reserved by other users. However, your administrator may configure meetingmaker to let you send proposals even when a required resource is unavailable.

Consider the following notes when scheduling resources:

- If you select a meeting location from the guest list when you propose a meeting, its name is automatically inserted into the Location text box on the proposal.
- Resources designated “first come, first served” by the meetingmaker administrator will automatically respond "yes" if available or "no" if not available.
- You cannot select resources as CC or BCC guests.
- You cannot propose a meeting as a proxy for a resource. (Resources cannot propose meetings.)
- If you select a second room, meetingmaker asks if you want to replace the original room. This does not remove the original room from the guest list. It replaces the name of the room in the Location field.
CHAPTER 5

Activities and Banners

This chapter outlines how to schedule an activity and create a banner.

Topics include:
• Scheduling an activity
• Modifying scheduled activities
• Changing an activity to a meeting
• Adding a banner
• Creating a banner
Activities

An activity is any event on your calendar other than a meeting or a banner. Except for your proxies, other users can not see your activities, but they can see that you are busy during those times.

Some of the things you might enter as activities include the following:
- Time set aside for independent work
- Appointments with people who don’t have meetingmaker
- Lunch hours, outside appointments, or other personal time

Scheduling an Activity

Scheduling an activity involves the following steps:
- Entering a title and time for the activity.
- Adding notes for more information (optional).
- Making the activity private and/or flexible (optional).
- Specifying reminder or label options (optional).
- Adding the activity to your calendar.

Entering an Activity on Your Schedule

To enter a title and time for the activity:
1. Select **New Activity** from the File menu to display the New Activity window, or do one of the following:
   - Drag open a box to create an activity on your daily calendar. When you release the mouse button, the New Activity window displays with the date, time, and duration you indicated
   or
   - Double-click the date of the activity on your monthly calendar.
2. Enter an activity title and location (optional).

3. To enter an activity time, click the Schedule tab.

   Click any part of the date, time, or duration you want to change, and enter a new date or time, or use the arrows that appear to change the date or time. Double-click the date to use the Navigator to select a date.

   To set aside the whole work day for the activity, click All Day.

   Set activity frequency as you would for meetings. For information on setting a frequency for recurring activities, see “Scheduling Recurring Meetings” on page 94.

4. Add any of the following optional information:
   - Add activity notes.
   - Set reminder and label options.
   - Make the activity private and/or flexible.

5. When you finish specifying your activity, click Create.
Scheduling an Activity

Activity Notes

Use the Notes area to add more information about an activity. Importing text files into the Notes area of the activity window replaces any existing text. Enter additional text after opening the file.

❖ To add notes to the activity:
  1. Click Notes.
  2. Enter any information you want to add.

        Copy text from another document into the notes area using the Copy and Paste commands. Click Open and select a text file to import into the Activity Notes area.

Specifying Reminder and Label Options

You can specify if and when you receive a reminder notification of the activity, and whether the activity is labeled.

❖ To set a reminder for an activity:
  1. Click Options. The Options panel displays.
  2. Select when to receive the activity reminder.

Color-Coded Labels

You can color-code activities for easy identification. Attach a label from the daily or monthly calendar by selecting the activity and choosing a label from the Label menu.

❖ To color-code label an activity:
  1. Click Options.
  2. Select the desired label from the Label menu.

        Use Preferences to customize labels for your own use. See “Changing Labels Preferences” on page 69 for more information.
Flexible and Private Activities

When someone invites you to a meeting that conflicts with an activity on your calendar, you appear busy to the proposer. If you mark the activity Flexible, the activity appears on your calendar, but you still appear available to other users.

Normally, your proxies can view all details of activities on your calendar. Marking the activity Private prevents proxies from seeing or printing the title or the details of the activity.

- Click **Flexible** to let other people know you are available to attend meetings at the time of this activity.
- Click **Private** to keep proxies from reading activity descriptions.

Modifying Scheduled Activities

- **To review or modify an activity:**
  1. Click the activity and then select **Open Activity** from the File menu, or double-click the activity on your calendar. The Activity Information window displays.
  2. Review or change any aspect of the activity.
     - Click **Update** to save changes to a modified activity.
     - Close the Activity window to discard the changes.

- **To remove an activity from your calendar:**
  1. Click the activity on your calendar to select it.
  2. Choose **Cancel Activity** from the Edit menu or press the **Delete/Backspace** key.
Changing an Activity to a Meeting

Include other people in an activity by changing it to a meeting.

To change an activity to a meeting:

1. Open the activity.
2. Click the Invite Guests button. The activity closes and a Meeting Proposal displays. The title, time, and duration of the activity (and any options you may have set) are kept for the meeting proposal. Any activity notes become the meeting’s agenda.
3. Add a meeting location and guests as in a meeting proposal.
4. Click Send Proposal.
5. To cancel the meeting proposal and leave the activity on your calendar, click the Close box.
Banners

A banner is a streamer that you drag across one or more days above the splitter bar of your daily calendar. Banners can be used to place events on your calendar without having them affect your free or busy time.

Banners can span as many days as you specify. Banners default to be flexible, which means they do not affect your free and busy time. However, you can change the option so it blocks off your calendar as busy time for the days that the banner spans. In addition, you can have multiple banners overlapping on the same day. To add a new banner, select the New Banner option under the File menu of the daily calendar, or drag the mouse across the days that you want to block, above the splitter bar. A flag icon indicates a flexible banner on the monthly calendar. A clock icon indicates a private banner.

Adding a Banner

Adding a banner to your schedule involves the following steps:

- Entering a title and location for the banner.
- Entering the date range that the banner will span.
- Adding notes for more information (optional).
- Setting reminder and attribute information, such as whether the banner is to be private, publishable or flexible (optional).
- Creating the banner.

About the Banner Information Screen

The Banner Information screen is where you define the parameters for your banner (such as name, date range, color, etc.). There are four tabs on this screen you can click to move into other entry screens.
The following is a description of each tab and the controls on each panel on the Banner Information screen:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Banner**      | Click this tab to enter the title of the banner as well as the location (optional).  
                  **Title**: the name of the banner (e.g., Trade Show).  
                  **Location**: your location while away (e.g., San Francisco, CA). This will also appear on the banner. |
| **Schedule**    | Click this tab to enter the date range that the banner is to span.  
                  **Start Date**: the date the banner will first appear on your schedule. The default date is today's date.  
                  **End Date**: the last date the banner will appear on your schedule. |
| **Notes**       | Click this tab to enter notes about the banner.  
                  You have the option of typing the notes or importing notes from another file.  
                  **Open**: click this button to import a file to include as notes.  
                  **Save as**: click this button to save your notes to a text file. |
| **Options**     | Click this tab if you want to be reminded of the start date for the banner, color code the banner for easy recognition, or make the banner private, publishable, and/or flexible.  
                  **Reminder**: click the radio button that represents the date and/or time that you want to be reminded about the banner. |

There are the following two types of Attributes:

- **Label** lets you color your banner for easy recognition.
- Select a radio button that best describes how you want to present the banner: Private or Flexible. Selecting **Flexible** does not block busy time on your calendar. Leaving Flexible unchecked blocks your calendar, and you appear unavailable to other users.
Creating a Banner

To create a banner:

- Select **New Banner** from the File menu or
- Drag the mouse across the splitter bar on the days you want the Banner to span.

The **New Banner** window displays:

6. Enter the title of the banner in the Title field.

7. Enter a location to display on the banner (optional).

8. Click the **Schedule** tab to enter the date range you want the banner to span. If you created the banner by dragging the mouse across the days you want to span, proceed to the next step.

9. Click the **Notes** tab to add information about your banner. If you do not want to add notes, proceed to the next step.

10. Click the **Options** tab to set reminders, and/or to make the banner private or flexible. Selecting Flexible does not block busy time on your calendar. Leaving Flexible unchecked blocks your calendar, and you appear unavailable to other users.

11. Click **Create Banner**.
A banner will appear on your daily calendar spanning the dates you specified.

**Entering Banner Notes**

You can enter notes about the banner that can be read by anyone with access to your schedule.

❖ **To add notes to a banner:**

1. Click the **Notes** tab. A text entry window displays.
2. Enter notes using one of the following methods:
   - Type the notes directly in the window
   - Import a text file by clicking the **Open** button.

   Note: If you are going to import a text file, as well as type banner notes, make sure to wait until the file is imported before typing the additional notes, because the file-importing process will delete any text in this window.

You can save the notes to a text file by clicking on the **Save as** button.

A user can access your banner notes by double-clicking the banner from the daily or monthly calendar.

**About the Reminder and Banner Options**

Click the **Options** tab to do either of the following optional tasks:

- Set up electronic reminders that will alert you anywhere from 31 days to one minute prior to the start date of the banner,
- Define banner attributes such as color and viewing status (i.e., private or flexible).
Defining the Reminder Options

To set up an electronic reminder from the Banner Information screen:

1. Click the Options tab to display the Options panel:

2. Click the date and/or time you want to receive notification about the start date of your banner.

3. Click the Create Banner button for a new banner or the Update button if you are modifying an existing banner.

Adding Color to a Banner

To color a banner from the Banner Information screen:

1. Click the Options tab. A window containing banner attributes displays.

2. Click the Label button. A list of label numbers and colors displays.

3. Select the label number corresponding to the color you want to apply to the banner.

4. Click the Update button.
Defining the Viewing Status of a Banner

The viewing status of a banner lets those who view your schedule know whether the time you have blocked is private or flexible.

To apply the viewing status from the Banner Information screen:

1. Click the Options tab. A window containing two radio buttons under the Attributes section displays.
2. Click any of the following radio buttons that corresponds to the viewing status you want to give the banner:
   • Private
   • Flexible
3. Click the Update button to save the new viewing status.
CHAPTER 6

Proposals

This chapter discusses the six kinds of meetingmaker proposals, as well as how to sort and delete proposals.

Topics include:

- The Proposals window
- Sorting proposals
- Deleting proposals
The Proposals Window

The meetingmaker Proposals window displays all six proposal types. Unopened proposals are displayed in bold type.

Active Proposals

Active proposals include new meeting proposals, meeting changes and responses to your proposals. Active proposal types are as follows:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄</td>
<td>New meeting invitation or to-do request</td>
</tr>
<tr>
<td>🔄</td>
<td>Rescheduled meeting</td>
</tr>
<tr>
<td>☎</td>
<td>Canceled meeting</td>
</tr>
<tr>
<td>✅</td>
<td>Confirmed meeting</td>
</tr>
<tr>
<td>🔄</td>
<td>Changed meeting</td>
</tr>
</tbody>
</table>
1. Select Proposals from the View menu.
2. Click the Active Proposals folder to open it.
3. Select a proposal to read (for example, a meeting proposal) and click Open, or double-click the proposal title.
4. Read the proposal, enter your response, and click Reply.

Once you act on active proposals, they are removed from the Active Proposals folder.

**To-Do Proposals**

This folder shows all To-Do item proposals you receive from other users.

1. Select Proposals from the View menu.
2. Click the To-Do Proposals folder to open it.
3. Select a To-Do proposal to read and click Open, or double-click the To-Do proposal title.
4. Read the proposal, enter your response, and click Reply.

**Notes About To-Do Proposals**

- Once you accept a To-Do item, it moves from the To-Do Proposals folder to the To-Do List. It remains on the To-Do List until deleted.
- If you refuse a To-Do item, it appears in the Your Refusals folder.
- If you choose I’ll decide later, the proposal stays in the To-Do Proposals folder until you act on it.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔩</td>
<td>Declined meeting</td>
</tr>
</tbody>
</table>
Your Proposals

This folder shows all the meetings you have proposed. Proposals are listed until they occur or are canceled. Icons indicate proposal status.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>All required guests have accepted your invitation.</td>
</tr>
<tr>
<td>❓</td>
<td>Some required guests have not yet responded.</td>
</tr>
<tr>
<td>✖️</td>
<td>At least one required guest has declined your invitation.</td>
</tr>
</tbody>
</table>

To view a proposal, select the meeting title in the Proposals window and click Open, or double-click the meeting on your calendar.

Your Refusals

This folder holds all of your declined meeting proposals (including declined single instances of recurring meetings), and declined to-do requests. You can accept proposals you initially refused while they remain on the refusals list.

By default, refusals are deleted when the meeting date passes. In User Preferences (see “Using Preferences” on page 62), you can define how long meetingmaker waits before deleting refusals. Accepting an initially-refused invitation removes the refusal from the Your Refusals folder and adds the meeting to your calendar, or the to-do item to your To-Do List.

❖ To change a refusal to an acceptance:
  1. Select the item from the Your Refusals list and click Open, or double-click the item.
  2. Change your response and click Reply.

Declining a Single Instance of a Recurring Meeting

Use the Decline Single Instance option whenever there is a recurring meeting on your schedule that you are unable to attend on one of the designated days.
To decline a single instance of a recurring meeting, navigate to the day of the recurring meeting and change your acceptance to a decline. A window appears asking if you want to decline the recurring meeting for this instance only or for every instance. You have the option of declining as many instances as you prefer.

Once you decline a single instance of a recurring meeting, a message appears in your refusal folder to indicate this.

**CC Proposals**

This folder holds all the CC and BCC proposals you receive for meetings. CC and BCC meeting proposals appear in your Active Proposals folder. Once opened, the CC or BCC meeting proposal moves from the Active Proposals folder to the CC Proposals folder until deleted.

่ม To view a CC proposal:

1. Select the proposal and click **Open**, or double-click the proposal.
2. Choose **Yes** or **No** to place the event on your calendar.
   Note: Placing CC or BCC events on your calendar will not affect your free or busy time.
3. Click **Reply** to acknowledge receipt of the CC proposal.
   Note: You can decide to add or remove the CC or BCC event from your calendar after you have closed the Proposals window. In your calendar, double-clicking the event and click **Yes** or **No**. Events that have already occurred cannot be modified.

**CC To-Do Items**

This folder holds all the CC and BCC proposals you receive for To-Do items. CC or BCC To-Do proposals appear in your To-Do Proposals folder. Once opened, the CC or BCC To-Do item moves from the To-Do Proposals folder to the CC To-Do Items folder until deleted.

่ม To view a CC To-Do item:

1. Select the To-Do proposal and click **Open**, or double-click the proposal.
2. Click **Reply** to acknowledge receipt of the CC To-Do item.
Sorting Proposals

You can sort the proposals in the Proposals window.

Note: You can not sort the folders in the Proposals window.

❖ To change the proposal list sort order:

1. Click the heading of the desired column. The column heading is underlined and the list sorts in ascending or descending order by that column.

2. Switch between ascending or descending order by clicking the icon at the right of the column titles in the Proposals window.

Deleting Proposals

Some proposals are automatically deleted when they no longer belong in a category. Accepted invitations you have initially refused are deleted from the Your Refusals folder and appear on your daily calendar. Active proposals are deleted when you act on them.

Proposals in Your Proposals, Your Refusals, or CC Proposals can be automatically deleted after the applicable event occurs.

To manually delete a proposal, select the proposals and click Delete.
This chapter discusses meetingmaker messages, such as, as well as how to sort and delete proposals.

Topics include:

- Overview of the Messages Window
- Working with the Messages Window
- Reminder Messages
- Instant Messages
The Messages Window

The meetingmaker Messages window provides a centralized message center where you receive all meetingmaker messages. The Messages window displays messages such as meeting and activity reminders and instant messages in one place. The Messages window retains a chronological history of all your messages, so you can easily manage them. For example, you can snooze or dismiss meeting reminders, send and respond to incoming instant messages, and copy and paste conversation histories into text applications, to save for later reference.

Note: When you sign out of meetingmaker, all messages in the Messages window are discarded.
CHAPTER 7: Messages

Working with the Messages Window

Types of Messages
The meetingmaker Messages window displays the types of messages listed below.

- Reminder Messages: Reminder messages alert you to upcoming meetings, activities, banners and To-Do Items for which you have set a reminder time.
- Instant Messages: Instant messages contain text that you have sent to or received from another meetingmaker user.
- Broadcast Messages: Broadcast messages contain important information from your meetingmaker Administrator. All meetingmaker users who are currently logged in receive every broadcast message.
- Server Messages: Server messages alert you to events related to the meetingmaker server that may affect you. For example, a server message may inform you that you have been disconnected from, or reconnected to, the meetingmaker server.

Working with Messages
You can cut, copy, and paste text from the Messages window into other text-editing applications. For example, you may want to save a record of an instant message conversation. You can also delete messages from the Messages window.

To cut, copy, and paste message text:
1. In the Messages window, click the message you want to cut or copy. To select multiple messages, hold down the CTRL key and click the messages you want to select.
   
   meetingmaker highlights the selected message or messages.
2. From the Edit menu, select Cut or Copy.
3. In your text editor, paste the message text into a new or existing document.
   
   You can now use the text editor to edit and save the text.
Working with the Messages Window

- **To delete a message:**
  1. In the Messages window, click the message you want to delete. To select multiple messages, hold down the CTRL key and click the messages you want to delete.
     
     meetingmaker highlights the message or messages you select.
  2. Press the DELETE key.
     
     meetingmaker deletes the selected message or messages.

**Reminder Messages**

Reminder messages alert you to upcoming meetings, activities, banners and To-Do items. You receive reminder messages when you set a reminder time for an event or To-Do, or when you set a default reminder time in your Notification Preferences. When you receive a reminder, you can open the message, and then choose to be reminded again later, dismiss the message, or open the event or To-Do.

- **To open a reminder message:**
  1. In the Messages window, double-click the reminder you want to open.
     
     A dialog box opens, and displays the reminder options.
  2. Select a reminder option:
     
     • To be reminded again later, select when you want to receive another reminder, and click Snooze.
     
     • To view the details of the event or To-Do, click Open.
     
     • To dismiss the reminder, click Close. You will not receive another reminder for the event or To-Do.

**Instant Messages**

You can use instant messages to chat with other meetingmaker users. When you send an instant message, the message immediately appears in the recipient’s Messages window. If you want to see both sides of an instant message conversation in your Messages window, you can select Echo Messages to display the messages you send in your own Messages window. When you’re not available to chat, you can use Auto-Respond to automatically send a response to any incoming instant messages.
CHAPTER 7: Messages

Note: Although you can receive and respond to instant messages from any meetingmaker user, you can only send new messages to users in your QuickList. To learn how to add users to your QuickList, see “Using Your QuickList” on page 91.

❖ To send an instant message:

1. In the Messages window Send To list, select the user to whom you want to send a message. Only users in your QuickList appear in the Send To list.

2. In the Message Text box, type your message.

   Your message can be up to 255 characters in length.

3. If you want messages you send to appear in your Messages window, click the Echo Messages check box.

4. Click Send.

   Your message appears in the recipient’s Messages window.

   Note: If the recipient is not logged in to meetingmaker, the message will not be delivered. In this case, meetingmaker displays a message informing you that the recipient is not online.

❖ To view an instant message:

   Note: If a message is long, some message text may not appear in the Messages window. You can open the message to see the entire message text.

1. In your Messages window, double-click the message you want to view.

   A dialog box opens, and displays the message text. You can cut, copy and paste the message into a text-editing application.

2. Click OK to close the dialog box and return to the Messages Window.

❖ To respond to an instant message:

1. In the Messages window, click the instant message to which you want to send a response.

   The sender’s name appears in the Send To list.

   Note: You can respond to any incoming instant message, even if the sender is not in your QuickList. However, responding to a
message does not add the sender to your QuickList. To learn how to add users to your QuickList, see “Using Your QuickList” on page 91.

2. In the Message Text box, type your message.
   Your message can be up to 255 characters in length.

3. If you want messages you send to appear in your Messages window, click the Echo Messages check box.

4. Click Send.
   Your response appears in the original sender’s Messages window.

❖ To Auto-Respond to instant messages:

1. In the Messages window Message Text box, type the message you want to automatically send.

2. Click the Auto-Respond Message check box.

3. Click Send.
   meetingmaker sends this message in response to any incoming instant message. To resume responding to instant messages, clear the Auto-Respond Message check box.
CHAPTER 8

To-Do Lists

The To-Do List is a powerful time-management tool for you and your group. This chapter discusses how to create and change a To-Do List.

Topics include:

- Creating a To-Do List
- Changing the To-Do List
- Changing the appearance of a To-Do List
Creating a To-Do List

The To-Do List can contain two types of items:

- Individual To-Do items for tasks that you create for yourself.
- Group To-Do items for tasks you work on as part of a group effort. Group To-Do items include tasks you propose to other users or that others propose to you.

Creating Individual To-Do Items

Create To-Do items for tasks you need to complete. To-do items include the following attributes: Category, Date, Priority, and Percent Done.

To create a To-Do item:

1. Select To-Do List from the View menu.
2. Click **New**. The To-Do Item window displays:

![To-Do Item Window](image)

3. Enter a **Title** for the new item.
4. Choose a **Category** from the Category list. The default Category label is None.
   
   **Note:** You can customize the category labels. See “Changing To-Do Preferences” on page 70.
5. Choose a **Priority** from the Priority list. The default Priority label is Normal.
   
   **Note:** You can customize the priority labels. See “Changing To-Do Preferences” on page 70.
6. To associate a date with the item, click **Date** and specify a completion date.
7. To add more information, click the To-Do tab, and enter additional text.
8. Select **Private** if you don’t want others to be able to view the title or notes on a To-Do item.
9. You can enter a **Percent Done** to track your progress on a To-Do item.
10. Click **Create** when finished creating the To-Do item. The item appears on your To-Do List.
Creating a To-Do List

To set a reminder for a To-Do item:
1. Click the Reminder tab in the To-Do Item window.
2. Specify a date to be reminded of the To-Do item. The default date is set to today.
   Note: To receive reminders when not using meetingmaker, run meetingmaker minimized.

Creating Group To-Do Items

You can create group To-Do items for tasks that include other people. With group To-Do items, you create the item and then specify participants. You can add any number of meetingmaker users as participants.

To create a group To-Do item:
1. Click New in the To-Do List window.
2. Enter a title, category, date and priority, as in an individual To-Do item.
3. Add notes and set a reminder if desired.
4. Click Participants and select people to include.
5. Click Private to keep proxies from viewing the item if desired.
6. Click Create when finished.

   The item appears on your list, and a proposal is sent to all participants. The proposal appears in participants’ Proposals window in the To-Do Proposals folder.

   Participants can respond with one of the following:
   • Will Do accepts the proposal and adds it to their To-Do List.
   • Won’t Do declines the proposal.
   • I’ll Decide Later defers the decision.
   • Done, if the task is completed.

Responding to a Group To-Do Request

When you receive a To-Do item, it appears in the To-Do Requests folder in your Message list.
To respond to a proposed To-Do item:

1. Double-click the item in the Message window. The To-Do Request window displays:

   ![To-Do Request Window]

   - Title: Registration list compilation
   - Category: None
   - Date: Wed, 1/24/2001
   - Priority: Normal

2. Read any notes attached by the proposer. You cannot modify the notes.

3. Click **Comments** to send additional information back to the proposer if desired.

4. To save your comments as a text file, click **Save as**.

5. Click Reminder to set a To-Do item reminder if desired.

6. Click one of the option buttons to respond:
   - **Will Do** accepts the proposal and adds it to your To-Do List.
   - **Won’t Do** declines the proposal.
   - **I’ll Decide Later** defers the decision.
   - **Done** if the task is completed.

7. Click **Reply** to send your response to the proposer.
Changing the To-Do List

If you create a To-Do item (for yourself or for a group), you can change any aspect of the To-Do item.

If you receive a To-Do item from another user, you can only change the reminder, the priority settings, and your response to the item. You can also mark the item as done.

Changing To-Do Item Details

To change a To-Do item:
1. Open the To-Do List and double-click the item you want to change, or click the item and then click Open.
2. For To-Do items you created, you can change the title, date, priority, notes, reminder, or participants.
   For group To-Do items requested by other users, you can change the item priority and reminder, as well as mark it private. However, you can not change the title, date, or notes.
3. Click Update.

Tracking To-Do Item Progress

As you work on a task in the To-Do List, you can track your progress by entering a percentage of work you have completed.

To track progress on a To-Do item:
1. In the To-Do List window, double-click the item you want to change.
   The To-Do Item window opens, and displays the details of the To-Do.
2. In the Percent Done field, enter the percentage of work you have completed. To indicate that an item is complete, check Done.
3. Click Update.
   The percent done appears in the To-Do list next to the completed item.

Note: When you mark a task 100 percent done, a check mark appears in the To-Do list next to the completed item.
CHAPTER 8: To-Do Lists

❖ To mark a To-Do item as done:

In the To-Do list, click the % Done column next to the item you want to mark as done.

A check mark appears in the To-Do list next to the completed item. To mark a completed item as not done, click the % Done column again.

Deleting To-Do Items

❖ To delete a To-Do item:

1. Open the To-Do List and select the item you want to delete.
2. Click Delete to remove the item from the To-Do List.

Note: You can only delete a To-Do item that you created.

Changing the Appearance of a To-Do List

You can sort the To-Do List and rearrange the columns as desired.

Sorting the To-Do List

You can sort the To-Do List in ascending or descending order by column.

❖ To sort the To-Do List:

1. Click the heading of the column to sort the To-Do List. The column heading is underlined, and the list sorts in ascending or descending order by that column.
2. Switch between sorting in ascending or descending order by clicking the icon above the scroll bar at the right of the To-Do List.

Rearranging the To-Do List Columns

You can rearrange the order of columns and change the width of the columns in the To-Do List.

❖ To rearrange the columns in the To-Do List:

1. Click the heading of the column to move and drag it to the new location.
2. To change column width, click the divider between column headings and drag to the left or right.
A proxy is someone to whom you give access to your meetingmaker calendar. This chapter covers how to use proxies.

Topics include:
- Assigning proxies
- Private meetings, activities and to-do items
- Accessing another user’s calendar as a proxy
Assigning Proxies

You can add proxies to, and delete them from, your proxy list. You can also arrange the order in which your proxies appear in your proxy list.

❖ To assign proxies:

1. From the Edit menu, select **Proxy List**.
   
   The Edit Proxies dialog box appears:

   2. Select the desired user(s) as a proxy and click either **Read/Write** or **Read-Only**. (You can switch a proxy between read/write and read-only status at any time.)

   Note: Proxies can be on any attached meetingmaker server.
   
   Note: When a proxy is assigned, the new proxy must restart meetingmaker to update their proxy list.

❖ To arrange the order of your proxy list:

1. In the menu bar, select **Proxy**.
   
   The Proxy menu appears, and displays an alphabetical list of your proxies.

   2. In the Proxy menu, hold down the CTRL key and click proxy that you want to move to the top of the list.

   The Proxy menu disappears. The next time you open the Proxy menu, the proxy you selected will appear immediately after your own name in the proxy list.
To remove someone from your proxy list:

1. Click the name in the right scroll box.
2. Click **Remove**.

**Messages**

You can choose one of your read/write proxies to receive your messages. When this proxy has your calendar open, she receives reminders and messages you would receive in your Messages window, in her own Messages window. Only one person can receive meetingmaker messages, so if you designate a proxy to receive your messages, you will not receive them in your Messages Window.

**Note:** Proxies do not have access to your Messages window. If you designate a proxy to receive your messages, he receives your messages in his own Messages window.

**Note:** Instant messages may contain private information. Because of this, proxies do not receive instant messages, even if you designate a proxy to receive your messages.

To send your messages to a proxy:

1. In the Edit Proxies dialog box, select the desired proxy from the **Send Proposals To** list.

When the selected proxy has your calendar open, he now receives your messages in his Messages window.

**Private Meetings, Activities and To-Do Items**

Proxies see the descriptions of your activities or to-do items unless they are marked as “private.” Any notes added to a private activity or to-do are also private.

Proxies cannot reschedule, open, print, or delete private meetings or activities. Private to-do items do not appear when proxies view a To-Do List.

Meetings marked as private are private on your calendar only. Invitees will not have an option to mark meetings as private.

To make an activity or to-do item private:

1. Click **Private** when creating the activity or to-do item.
Accessing Another User’s Calendar as a Proxy

If another meetingmaker user makes you their proxy, you can access that person’s schedule.

❖ **To proxy another user’s calendar:**

1. From the Proxy menu, select the user whose calendar you want to view.

   meetingmaker displays the selected user’s calendar. Quotation marks around the person’s name indicate that you are that person’s proxy.

   As a proxy, you cannot view, change, delete, or print activities or to-do items the user has marked as “private.”

2. To return to your own calendar, select your own name from the Proxy menu, or click anywhere on your own calendar.

Receiving Another User’s Notifications

When receiving someone’s active message notifications, a diamond appears next to that person’s name in the Proxy menu.

Note: If you are a read-only proxy, you cannot create, change, delete, or print an activity, meeting, or to-do item.

You must have a person’s calendar open in order to receive their message notifications.

Before working offline, follow the steps below to ensure that the offline computer contains the necessary meetingmaker account data.

❖ **To proxy another user’s calendar while working offline:**

1. Make sure that meetingmaker is installed on the offline computer.
2. Make sure that the computer is connected to the network.
3. Double-click the meetingmaker icon to start meetingmaker.
4. Sign in to meetingmaker.
5. Use the Proxy menu to select the calendars to proxy while working offline. This creates a data folder for your meetingmaker account on that computer.
6. Sign out. You can now work offline.
When reconnecting to the server, meetingmaker updates any calendars you worked on and sends proposals for meetings or to-do items created offline.

**Viewing Another User’s Calendar in a Different Time Zone**

When you are a proxy for another user, you can view that person’s calendar in a time zone that you select. For example, if a colleague whose home office is in a different time zone will be visiting your office, you can proxy his or her calendar, and display it in your local time zone. This allows you to view, in your time zone, your colleague’s availability while visiting your office.

When you change the time zone for a proxied calendar, you are changing only the "display" time zone. This means that events currently on the proxied calendar are shown in the time zone you select. You can not change the "work hour" time zone for a proxied calendar.

For more information on display time zones and work hour time zones, see “Changing your Display Time Zone” on page 49, and “Changing your Work Hour Time Zone” on page 77, respectively.

❖ **To view another user’s calendar in a different time zone:**

1. From the Proxy menu, select the user whose calendar your want to view.
   
   meetingmaker displays the selected user’s calendar.

2. From the Edit menu, select **Time Zone**.
   
   The Select a Time Zone dialog box appears.
3. Select the time zone in which you want to display the proxied calendar, and click OK.

meetingmaker displays the proxied calendar in the time zone you selected.

Viewing Several Calendars at Once

As a proxy, you can display daily views of several users’ calendars so they all fit on the screen at the same time.

❖ To view several calendars at once:

1. Select Tile Daily from the View menu while the desired calendars are open.

Resource Proxies

You can also act as a proxy for a resource. A read-only proxy to a resource, such as a meeting room or piece of equipment, can view the events associated with that resource. A read/write proxy to a resource can view or modify events. Your meetingmaker administrator has to assign you proxy rights to the resource.
CHAPTER 10

Printing

This chapter explains how to print your Calendar, Contact List and To-Do List, as well as the contents of your Proposals and Messages windows.

Topics include:

- Printing Your Calendar
- Printing Your To-Do List
- Printing Your Contact List
- Printing Your Proposals
- Printing Your Messages
Printing Your Calendar

You can print your calendar in a variety of schedule layouts, from a single day per page to an entire year per page on both black and white and in color. You can also print your schedule to fit various personal planners.

To print your schedule:

1. Select Print Schedule from the File menu.
2. Enter a start date and end date to print.
3. Select a form to print from the Forms list.
   
   The standard forms are described below. For descriptions of additional forms in your window, contact your meetingmaker administrator.

   • Daily prints your daily calendar for the specified dates. On a color printer, any items that have a color label print in color.
   • Weekly prints your weekly calendar for the specified dates. On a color printer, any items that have a color label print in color.
   • Monthly prints your monthly calendar for the specified dates. On a color printer, any items that have a color label print in text of that color.
   • Yearly prints your yearly calendar for the specified dates. If you are printing on a color printer and in a format that displays calendar items, any items that have a color label print in text of that color.

   • Event Text prints the text of meeting agendas, notes, etc., for the specified dates.
   • To-Do List prints your to-do list for the specified dates.
   • Trifold prints a calendar for the indicated dates to a trifold format.
4. Click Page Layout to select a specific page format to use for printing your form (optional).
5. Select the page format you want from the list.
6. Review the thumbnail sketch of the layout to make sure it’s the one you want.
7. Click **OK** to accept your selection and return to the Print Schedule window.

8. Click on **Options** to change the appearance of the schedule(s) that will be printed from the form you’ve selected (optional).

   The Print Options dialog box displays, displaying a list of the schedules included with the form you’ve selected. From this window, you can change the options for any one of the available schedules.

   a. Select the schedule (daily, weekly, monthly, To-Do List, etc.) for which you want to change options.
   
   b. Use the Font and Size menus to change the font and font size if desired.

   Note: When changing font size, you may need to experiment to find the size that works best.

   c. Set other options for the selected view.

   For example, on the daily calendar, click **Print all days** or **Print work days** to specify which days are printed.

   d. Repeat the above steps to change options for other available schedules.

9. When finished changing options, click **OK** to save changes and close the Print Options dialog box.

### Printing a Single Event, Message, To-Do Item or Banner

To print the details of a single meeting, activity, or to-do item:

1. On your daily or monthly calendar, click the desired meeting or activity.
   
   - To print a to-do item, click the item on the To-Do List.
   
   - To print a message, click the item in the Message window.

2. Select **Print (Meeting, Activity, Message, To-Do Item, Banner)** from the File menu. The menu changes according to your selection. The selected item prints to the specified layout in the Print Options dialog box.
Printing Your To-Do List

You can print a single To-Do, or print multiple To-Do items at the same time.

You can print multiple To-Do items one per page, or in a list. To print To-Dos as they appear in the meetingmaker To-Do List window, print a list. To print all To-Do details, such as notes and participants, print one To-Do per page.

Printing a Single To-Do Item

❖ To print the details of a single To-Do item:

1. In the To-Do List window, double-click the item you want to print.
   
   The To-Do Item window appears, displaying the details of the selected To-Do.

2. From the File menu, select Print To-Do Item.
   
   meetingmaker prints the selected To-Do item.

Printing a List of To-Do Items

❖ To print a list of To-Do items:

1. In the To-Do window, click the To-Do items you want to print. To select multiple To-Do items, hold down the CTRL key (Windows) or Command key (Macintosh) and click the items you want.

2. Click Print.
   
   meetingmaker prints the selected To-Do items in a list.

Printing One To-Do Item Per Page

You can print the details of multiple To-Do items by printing one To-Do per page.

❖ To print one To-Do item per page:

1. In the To-Do window, click the To-Do items you want to print. To select multiple To-Do items, hold down the CTRL key (Windows) or Command key (Macintosh) and click the items you want.

2. Hold down CTRL or Command, and click Print.
meetingmaker prints each of the selected To-Do items on a separate page.
Printing Your Contact List

You can print a single contact, or print multiple contacts at the same time.

You can print multiple contacts one per page, or in a list. To print contacts as they appear in the meetingmaker Contact List window, print a list. The printed list will show only the contact fields that appear in the Contact List window. To print all contact details, including fields that do not appear in the Contact List window, print one contact per page.

Printing a Single Contact

- **To print all details of a single contact:**
  1. In the Contact List window, click the contact you want to print.
  2. Hold down the CTRL key (Windows) or Command key (Macintosh), and click Print.

    meetingmaker prints the selected contact.

Printing a List of Contacts

- **To print a list of Contacts:**
  1. In the Contact List window, click the contacts you want to print.
     To select multiple contacts, hold down the CTRL key (Windows) or Command key (Macintosh) and click the entries you want.
  2. Click Print.

    meetingmaker prints the selected contacts in a list.

Printing One Contact Per Page

You can print the details of multiple contacts by printing one contact per page.

- **To print one contact per page:**
  1. In the Contact List window, click the contacts you want to print.
     To select multiple contacts, hold down the CTRL key (Windows) or Command key (Macintosh) and click the entries you want.
  2. Hold down CTRL or Command, and click Print.
meetingmaker prints each of the selected contacts on a separate page.
Printing Your Proposals

You can print a single proposal, or print multiple proposals at the same time.

You can print your proposals one per page, or in a list. To print proposals as they appear in the meetingmaker Proposals window, print a list. To print all proposal details, such as the agenda and invited guests, print one proposal per page.

Printing a Single Proposal

❖ To print all details of a single proposal:

1. In the Proposals window, click the proposal you want to print.
2. Hold down the CTRL key (Windows) or Command key (Macintosh), and click Print.

meetingmaker prints the selected proposal.

Printing a List of Proposals

❖ To print a list of proposals:

1. In the Proposals window, click the proposals you want to print. To select multiple proposals, hold down the CTRL key (Windows) or Command key (Macintosh) and click the entries you want.
2. Click Print.

meetingmaker prints the selected proposals in a list.

Note: Headings in the Proposals window, such as "Active Proposals" do not appear in the printed list.

Printing One Proposal Per Page

❖ To print one proposal per page:

1. In the Proposals window, click the proposals you want to print. To select multiple proposals, hold down the CTRL key (Windows) or Command key (Macintosh) and click the entries you want.
2. Hold down CTRL or Command, and click Print.
meetingmaker prints each of the selected proposals on a separate page.
Printing Your Messages

You can select and print your messages.

To print messages:

1. In the Messages window, click the message or messages you want to print. To select multiple messages, hold down the CTRL key (Windows) or Command key (Macintosh) and click the messages you want.

2. From the File menu, select Print Message.

meetingmaker prints the selected message or messages. If you selected multiple messages, meetingmaker prints them in a list.
Printing Your Messages
Synchronizing Your meetingmaker Calendar with Palm OS Handheld Devices

This chapter discusses how to synchronize your meetingmaker calendar, contact list, and to-do list with Palm OS handheld devices. Topics include:

- Installing and Configuring the meetingmaker Conduits on Windows
- Installing and Configuring the meetingmaker Conduits on Macintosh
- Synchronizing with meetingmaker
- Restrictions of the meetingmaker Conduits

You can synchronize your Palm OS handheld device directly with your meetingmaker schedule. By using the meetingmaker conduits for Palm OS handheld devices, you can automatically synchronize your meetingmaker information with your handheld Palm OS Address Book, Date Book, and To-Do List.

If you already have Palm OS Desktop conduits installed on your workstation, the meetingmaker conduits for Palm OS handheld devices replaces the default conduits.

The meetingmaker conduit for Palm OS handheld devices runs on Windows 95, 98, Me, NT and 2000, and on Macintosh PPC.
Installing and Configuring the meetingmaker Conduits on Windows

System Requirements

- Windows 95, 98, Me, NT or 2000
- meetingmaker Client version 7.0 or higher installed on your Windows workstation
- A Palm OS handheld device (PalmPilot Personal, PalmPilot Professional, Palm III, Palm V, Palm VII, or Handspring Visor series)
- Palm Desktop 3.0 or later.
- TCP or IP communication protocol

Note: The protocol should be the same one normally used by the meetingmaker Client.

Setup

To use meetingmaker on your Palm organizer, complete the following steps. Be sure to follow the steps in the order given to ensure proper synchronization.

To set up meetingmaker synchronization:

1. Make sure meetingmaker is installed on your workstation. See Chapter 1, "Getting Started" on page 21 for more information about installing meetingmaker.
2. Install the Palm Desktop 3.0 or later software. Follow the installation instructions in the Palm Desktop documentation.
3. Sign in to meetingmaker and synchronize with the Palm Desktop.

Installation

The meetingmaker conduits for Palm OS handheld devices are installed as part of the meetingmaker Client installation. If, during the installation, the Palm Desktop software is detected, you will be prompted to install the meetingmaker conduits.

Your meetingmaker administrator can choose to not enable the install of the meetingmaker conduits for network installations. If this is the
case, you will need to get a version of the meetingmaker Client that includes the meetingmaker conduits from your administrator.

If you install the Palm Desktop after installing the meetingmaker Client, you will need to reinstall the meetingmaker Client to install the meetingmaker conduits.

**Configuring Synchronization**

Follow these steps to configure meetingmaker synchronization with your Palm organizer.

To configure meetingmaker synchronization with your Palm organizer:

1. Click the **HotSync** icon in your Windows system tray (located in the lower right corner of your screen).

2. Select **Custom**. The Custom dialog box displays:

   ![Custom dialog box](image)

3. From the pull-down menu, select your username.

4. Select a meetingmaker Conduit from the Conduit list and click **Change** to configure your selection. See the following sections for configuration options.

   or

   Click **Done** if the Actions are correct. The Action is the action the conduit will take when a HotSync update is done.

The following sections describe the three meetingmaker Conduits and their configuration options.
**meetingmaker DateBook Conduit**

The meetingmaker DateBook conduit synchronizes your meetingmaker calendar with the Palm DateBook. This includes meetings, activities, and banners.

To configure the meetingmaker DateBook conduit:

1. Highlight the **meetingmaker DateBook** conduit and click **Change...** to display the options. The Date Book Conduit Configure dialog box displays:

2. Enter your meetingmaker login name, your meetingmaker password (if any), your server name, and the network protocol.
Note: The protocol should be the same protocol used by your regular meetingmaker client. Your administrator can tell you which protocol to select.

3. Select one of the following Actions from the Date Book Settings pull-down menu:

- **Synchronize the files** performs a two-way synchronization between meetingmaker and the Palm organizer.
- **Desktop overwrites handheld** performs a one-way synchronization from meetingmaker to the Palm organizer.
- **Handheld overwrites desktop** performs a one-way synchronization from the Palm organizer to meetingmaker.
- Select **Do nothing** if you want no data to be exchanged between meetingmaker and the Palm organizer.

4. Select a Synchronize Range.

- **Days before today**: synchronize events on all days before today or for a specific number of days.
- **Days after today**: synchronize events on all days after today or for a specific number of days.

5. Select a time zone for your DateBook. When you synchronize, the DateBook will display your meetingmaker calendar in the time zone you select.

Note: You must select a time zone in order to successfully synchronize meetingmaker with your Palm device.

6. Select a location for the meetingmaker to Palm synching file. This file matches meetingmaker calendar records to Palm DateBook records.

- **ID Files on Palm and Desktop: (recommended)** Saves a copy of the ID file on both your Palm device and your local computer’s hard drive. If one copy of the ID file is lost or corrupted, you can synchronize successfully using the other copy.
- **ID Files on Palm Only**: Saves a copy of the ID file on your Palm device. If you share a computer, you can use this option to protect your calendar security.
- **ID Files on Desktop Only**: Saves a copy of the ID file on your local computer’s hard drive. You can use this option if your Palm device has limited memory available.
Installing and Configuring the meetingmaker Conduits on Windows

7. Click **OK** to set the configuration options and return to the Custom dialog box.

**meetingmaker Address Conduit**

The meetingmaker Address conduit synchronizes your meetingmaker Contact List with the Palm Address Book.

**To configure the meetingmaker Address conduit:**

1. Highlight the **meetingmaker Address** conduit and click **Change...** to display the options. The Address Book Conduit Configure dialog box displays:

   ![Address Book Conduit Configure dialog box]

2. Enter your meetingmaker login name, your meetingmaker password (if any), your server name (case sensitive), and the network protocol.

   **Note:** The protocol should be the same protocol used by your regular meetingmaker client. Your administrator can tell you which protocol to select.

3. Select one of the following Actions from the Address Book Settings pull-down menu:
   - **Synchronize the files** performs a two-way synchronization between meetingmaker and the Palm organizer.
CHAPTER 11: Synchronizing Your meetingmaker Calendar with Palm OS Handheld Devices

- **Desktop overwrites handheld** performs a one-way synchronization from meetingmaker to the Palm organizer.

- **Handheld overwrites desktop** performs a one-way synchronization from the Palm organizer to meetingmaker.

- Select **Do nothing** if you want no data to be exchanged between meetingmaker and the Palm organizer.

4. Click **OK** to set the configuration options and return to the Custom dialog box.

**meetingmaker To-Do Conduit**

The meetingmaker To-Do conduit synchronizes your meetingmaker To-Do List with the Palm To-Do list.

**To configure the meetingmaker To-Do conduit:**

1. Highlight the **meetingmaker To-Do** conduit and click **Change...** to display the options. The **To-Do List Conduit Configure** dialog box displays.

2. Enter your meetingmaker login name, your meetingmaker password (if any), your server name (case sensitive), and the network protocol.

![Todo List Conduit Configure Dialog Box](image)
Note: The protocol should be the same protocol used by your regular meetingmaker client. Your administrator can tell you which protocol to select.

3. Select one of the following Actions from the To-Do List Settings pull-down menu:

   • **Synchronize the files** performs a two-way synchronization between meetingmaker and the Palm organizer.
   
   • **Desktop overwrites handheld** performs a one-way synchronization from meetingmaker to the Palm organizer.
   
   • **Handheld overwrites desktop** performs a one-way synchronization from the Palm organizer to meetingmaker.
   
   • Select **Do nothing** if you want no data to be exchanged between meetingmaker and the Palm organizer.

4. Click **OK** to set the configuration options and return to the Custom dialog box.
CHAPTER 11: Synchronizing Your meetingmaker Calendar with Palm OS Handheld Devices

Installing and Configuring the meetingmaker Conduits on Macintosh

System Requirements

- Macintosh PPC with OS 8.6.1 or later
- meetingmaker Client version 7.0 or later installed on your Macintosh workstation.
- A Palm organizer (PalmPilot Personal, PalmPilot Professional, Palm III, Palm V, Palm VII, or Handspring Visor series)
- Palm Desktop 2.5 or higher. This is part of the Palm MacPac 2.5 or higher.
- TCP or IP communication protocol

Note: The protocol should be the same one normally used by the meetingmaker Client.

Setup

To use meetingmaker on your Palm OS handheld device, complete the following steps. Be sure to follow the steps in the order given to ensure proper synchronization.

To set up meetingmaker synchronization:

1. Make sure meetingmaker is installed on your workstation. See Chapter 1, "Getting Started" on page 21 for more information about installing meetingmaker.
2. Install the Palm Desktop 2.5 or higher software. Follow the installation instructions in the Palm Desktop documentation.
3. Sign in to meetingmaker and synchronize with the Palm Desktop.

Installation

The meetingmaker conduits for Palm OS handheld devices are installed as part of the meetingmaker Client installation. If, during the installation, the Palm Desktop software is detected, you will be prompted to install the meetingmaker conduits.
Your meetingmaker administrator can choose to not enable the install of the meetingmaker conduits for network installations. If this is the case, you will need to get a version of the meetingmaker Client that includes the meetingmaker conduits from your administrator.

If you install the Palm Desktop after installing the meetingmaker Client, you will need to reinstall the meetingmaker Client to install the meetingmaker conduits.

WARNING: The memory setting of the Conduit Manager must be changed to at least 6000K. If not, the Palm organizer and meetingmaker synchronization may fail.

**Configuring Synchronization**

Follow these steps to configure meetingmaker synchronization with your Palm organizer:

To configure meetingmaker synchronization with your Palm organizer:

1. Double-click the **HotSync** icon from the Palm directory.
2. Select **Configure** from the HotSync menu item. The Conduit Settings dialog box displays.
CHAPTER 11: Synchronizing Your Meetingmaker Calendar with Palm OS Handheld Devices

3. Double-click the **meetingmaker Conduit** to change the Next HotSync Action. See the following sections for configuration options.

   or

   Close the window to keep the current Next HotSync Action.

The following sections describe the three meetingmaker Conduits and their configuration options.

**meetingmaker Address Conduit**

The meetingmaker Address Conduit synchronizes your meetingmaker Contact List with the Palm Address Book.

To configure the meetingmaker Address conduit:

1. Double-click the **meetingmaker Address** conduit to display the options. The **Address Book Conduit Configure** dialog box displays:

   ![Address Book Conduit Configure](image)

2. Enter your meetingmaker login name, your meetingmaker password (if any), your server name (case sensitive), and the network protocol.

   Note: The protocol should be the same protocol used by your regular meetingmaker client. Your administrator can tell you which protocol to select.

3. Select one of the following Actions:
Installing and Configuring the meetingmaker Conduits on Macintosh

- **Synchronize the files** performs a two-way synchronization between meetingmaker and the Palm organizer.
- **Desktop overwrites handheld** performs a one-way synchronization from meetingmaker to the Palm organizer.
- **Handheld overwrites desktop** performs a one-way synchronization from the Palm organizer to meetingmaker.
- Select **Do nothing** if you want no data to be exchanged between meetingmaker and the Palm organizer.

4. Click **OK** to set the configuration options and return to the **Conduits Settings** dialog box.

**meetingmaker Date Conduit**

The meetingmaker Date conduit synchronizes your meetingmaker calendar with the Palm Datebook. This includes meetings, activities, and banners.

**To configure the meetingmaker Date conduit:**

1. Double-click the **meetingmaker Date** conduit to display the options. The **Date Book Conduit Configure** dialog box displays.
2. Enter your meetingmaker login name, your meetingmaker password (if any), your server name (case sensitive), and the network protocol.

Note: The protocol should be the same protocol used by your regular meetingmaker client. Your administrator can tell you which protocol to select.

3. Select one of the following Actions:
   - **Synchronize the files** performs a two-way synchronization between meetingmaker and the Palm organizer.
   - **Desktop overwrites handheld** performs a one-way synchronization from meetingmaker to the Palm organizer.
   - **Handheld overwrites desktop** performs a one-way synchronization from the Palm organizer to meetingmaker.
   - Select **Do nothing** if you want no data to be exchanged between meetingmaker and the Palm organizer.

4. Select one of the following Ranges:
   - **Days before today**: synchronize events on all days before today or for a specific number of days.
   - **Days after today**: synchronize events on all days after today or for a specific number of days.

5. Click **OK** to set the configuration options and return to the **Conduit Settings** dialog box.

**meetingmaker To-Do Conduit**

The meetingmaker To-Do Conduit synchronizes your meetingmaker To-Do List with the Palm To-Do list.

**To configure the meetingmaker To-Do conduit:**

1. Double-click the **meetingmaker To-Do** conduit, to display the options. The **To-Do List Conduit Configure** dialog box displays.
2. Enter your meetingmaker login name, your meetingmaker password (if any), your server name (case sensitive), and the network protocol.

Note: The protocol should be the same protocol used by your regular meetingmaker client. Your administrator can tell you which protocol to select.

3. Select one of the following Actions:
   - **Synchronize the files** performs a two-way synchronization between meetingmaker and the Palm organizer.
   - **Desktop overwrites handheld** performs a one-way synchronization from meetingmaker to the Palm organizer.
   - **Handheld overwrites desktop** performs a one-way synchronization from the Palm organizer to meetingmaker.
   - Select **Do nothing** if you want no data to be exchanged between meetingmaker and the Palm organizer.

4. Click **OK** to set the configuration options and return to the **Conduit Settings** dialog box.
Synchronizing with meetingmaker

During synchronization, the Palm Desktop software communicates with the meetingmaker Palm Conduit, which in turn communicates directly with the meetingmaker server. Synchronization happens automatically from your Palm organizer to meetingmaker and from meetingmaker to your Palm organizer.

To synchronize your meetingmaker schedule with your Palm organizer:

1. From your Palm organizer docking cradle, press the **HotSync** button.
2. Once synchronization is complete, click **OK/accept** to accept the changes that occurred.

WARNING: If you perform a hard reset on your Palm organizer, you must delete the three .ID files located in the Palm directory before synchronizing again. On Windows, the path is `<palm directory>\<user directory>\mmcond\`. On Macintosh, the path is `<palm directory>\:users:\<user directory>`. Failure to delete these files may result in duplicated entries in meetingmaker.

Restrictions of the meetingmaker Conduits

The following items are not supported by the meetingmaker Palm Conduits. Events with these settings will not by synchronized with the Palm organizer. The non-synchronized events are listed in the HotSync log.

- Events that have an exact time/day reminder set. To set a default reminder for all events, see “Changing Notification Preferences” on page 65.
- Non-contiguous, no-time events.
- Some meetingmaker recurring meeting and activity settings. For example:
  - `<#>` days from end-of-month
• Some Palm organizer recurring meeting and activity settings. For example:
  • every <#> weeks, where <#> is greater than 2
  • every <#> months, where <#> is greater than 3
  • every <#> years, where <#> is greater than 1
CHAPTER 12

Internet HTML Publisher

This chapter details how to publish your calendar in HTML format. There are two methods you can use to publish your calendar. You can use the Publish feature in your meetingmaker Client, or your meetingmaker administrator can set up automatic publishing through the HTML Publisher servlet. In both cases, the HTML files can be posted as read-only information on the Internet or internally on your intranet.

Topics include:

- Internet HTML Publisher requirements
- Publishing your calendar with the Publish feature
- Publishing your calendar with the Real-Time HTML Publisher servlet
- Calendar views
Internet HTML Publisher Requirements

The following are the minimum requirements to publish calendars for viewing from a web browser:

**System Requirements**

- 486 or higher with Windows NT 3.51 or 4.0 or Windows 95/98
- 16MB of RAM and 5MB of disk space
- meetingmaker client version 6.0 or higher
  or
- Macintosh PPC with System 7 or higher
- 8MB of RAM and 6MB of disk space
- meetingmaker client version 6.0 or higher

Note: Macintosh 68K is not supported

**Web Browser Requirements**

- Netscape 4.5 or higher
- Internet Explorer 5.0 or higher

Note: You can view calendars on any system with the specified web browser. The system does not have to have meetingmaker installed. Published calendars are in HTML format.
CHAPTER 12: Internet HTML Publisher

Publishing your Calendar with the Publish Feature

You can publish your calendar in HTML format by using the Publish feature in the meetingmaker Client. You can choose how often to refresh the HTML calendar with updated information, as well as the range of dates to publish.

To set up publishing options and publish a calendar:

1. Select Publish from the File menu. The Publish Calendar dialog box displays:

![Publish Calendar Dialog Box]

2. Define how often the calendar will be published using the Frequency drop-down menu.
   - Manual only
   - Every 30 minutes
   - Every hour
   - Every 4 hours
   - Every day

Note: meetingmaker must be running on your local computer in order to publish your calendar in HTML format. If you choose to publish your calendar at a regular time interval, your HTML calendar will only be updated if meetingmaker is running.
3. Define how many months you want to publish using the From and To drop-down menus.
   
   - **From** indicates the month from which you want the published calendar to start. The options are *this month, last month, -2 through -11 months.*
   - **To** indicates the month that you want the published calendar to end. The options are *this month, next month, +2 through +11 months.*

4. In the Publish To field, type the path and file name of the root web page or click on **Browse** to choose a directory location. If a location is not specified, the file is placed in your meetingmaker directory.

   **Note:** On a Macintosh there is no field to type the path and file name. You must click **Browse** and choose a directory location.

   **Note:** Remember to add .htm or .html to the file name.

5. To have events display on your calendar, select **Publish all events not marked “Private.”** All events that are not specifically marked “private” are published.

   **Note:** If you do not select this option, only events that are Publishable get published. For more information about Publishable events, see the “Flexible, Private and Publishable Meetings” section in chapter 4.

6. Select **Show placeholders for unpublished events** to show a blocked out section of time for events that are not published.

   If you do not select this option, unpublished events do not display.

7. Click one of the following buttons:

   - **Publish** publishes the calendar in HTML format in the location you specified using the current settings.

   **Note:** Calendar publishing takes place on the client, so meetingmaker must be left running in order to update the published calendar.

   You may publish your calendar while working offline, and you may also publish a calendar while acting as a proxy.
• **OK** saves the current settings without publishing the calendar. The Publish Calendar dialog box disappears.

• **Cancel** exits the Publish Calendar dialog box without saving the current settings.
Publishing your Calendar with the Real-Time HTML Publisher Servlet

Your meetingmaker administrator can automatically publish your calendar in HTML format by using the Real-Time HTML Publisher servlet. Each time a user views your HTML calendar, the HTML Publisher servlet automatically refreshes the calendar with the most up-to-date version. Because the HTML Publisher servlet retrieves your calendar data directly from the meetingmaker server, the meetingmaker Client does not have to be running for the servlet to publish your HTML calendar.

To publish your calendar using the HTML Publisher servlet, you do not need to make any changes in the meetingmaker Client. Use meetingmaker as you normally do. Your meetingmaker administrator will set up the HTML Publisher servlet to publish your calendar automatically.

To view your calendar in HTML format, navigate your web browser to the Internet or intranet address where your calendar is published. Your meetingmaker or network administrator can provide you with this address.
Calendar Views

The Internet HTML Publisher is capable of publishing the following calendar views:

- **Summary page view**

  This view shows all requested published months. Days that have banners or events contain a link to the day view. This view is the default screen.
Calendar Views

- **Monthly page view**
  This monthly view of your calendar can be viewed by clicking on the appropriate month’s name.

- **Daily page view (single day)**
  This view shows one day of your calendar. To view a specific day and the events on that day, click the appropriate date in either the summary or monthly view screen.

- **Activity, banner, or meeting page view**
  This view shows the title, location, schedule, and notes for a particular event. Click an event from either the daily or monthly view to display these details.
The monthly, daily and event views contain a navigation panel that allows you to move easily from one page to another by clicking the appropriate arrow.
Calendar Views
CHAPTER 13

meetingmaker Java Client

The meetingmaker Java Client enables you to view and use your calendar from a web browser. This chapter describes how to use the meetingmaker Java Client.

Topics include:

- System requirements
- Signing in to the meetingmaker Java Client
- Using the meetingmaker Java Client
System Requirements

The following are the requirements for running the meetingmaker Java Client:

Web Browser
- Netscape 4.5 or higher
- Internet Explorer 5.0 or higher
- HotJava Browser 1.1.5

Java Virtual Machine (JVM)
- Java 1.1 Virtual Machine or later

RAM
- Windows: 48 MB of RAM is recommended. 32 MB of RAM is the minimum required to run the Java Client.
- Macintosh: 48 MB of RAM.
- Solaris: 48 MB of RAM

meetingmaker
- meetingmaker 7.0 or higher

Signing in to the meetingmaker Java Client

You can use the meetingmaker Java client either through your web browser, or as an independent application on your desktop.

To use the meetingmaker Java Client as an independent application, you must have a supported Java Virtual Machine (JVM) installed and running on your desktop computer. Create a shortcut on your desktop to the location on your web server where the meetingmaker Java Client is installed. Your meetingmaker Administrator can tell you the file path to the Java Client. To sign in to the Java Client, double-click the shortcut you created. The Welcome to meetingmaker sign-in box appears.

To sign in to the meetingmaker Java Client through your web browser, open a supported web browser. In your web browser’s address field, enter the URL of your meetingmaker Java Client. Your meetingmaker
Administrator can tell you the URL to enter. The Welcome to meetingmaker sign-in box appears:

![Welcome to Meeting Maker](image)

- **To sign in to the Java Client:**
  1. Click the **Name** field and enter your meetingmaker sign-in name. This is the same name that you use to sign in to your regular meetingmaker Client.
  2. If you have a password to meetingmaker, enter the same password in the **Password** field. If you do not have a password, leave the field blank.
  3. Select your Server from the **Server** drop-down menu. Your meetingmaker administrator can tell you which Server to choose.
  4. Click **Time Zone**, and select a time zone from the Select a Time Zone dialog box.
     
     This is your “display” time zone. When you select a display time zone, meetingmaker shows your calendar in the time zone you select. Normally, you should select the time zone in which you live, or spend the majority of your work hours. However, when traveling in a different time zone, for example, you may wish to see your calendar in local time. In this case, select the time zone in which you are traveling.

     For more information on display time zones, see “Changing your Display Time Zone” on page 49.
  5. Click **Sign In** to sign in to your Java Client.

     The meetingmaker Java Client opens.
Using the meetingmaker Java Client

The meetingmaker Java Client works like the desktop meetingmaker Client. Many of the features found in the meetingmaker desktop client are used the same way in the meetingmaker Java Client.

Proposing a Meeting

From the meetingmaker Java Client, you can propose a meeting by naming the topic and specifying a location. There are two ways you can propose a meeting:

- Clicking the New icon from the toolbar to open the New Activity dialog box. Invite guests to the activity and it becomes a meeting.
- Dragging a time on your calendar to open the New Activity dialog box. Invite guests to this activity and it becomes a meeting.

To propose a meeting in the meetingmaker Java Client:

1. Click the New icon on the toolbar or drag your mouse over the desired time.

   The New Activity dialog box displays:

   ![New Activity dialog box](image)

2. Type the title or topic of the meeting in the Title field.
3. Click the **Invite Guests** button. The Activity becomes a Meeting, and the Meeting Proposal screen displays:

4. The Guests tab is selected. Double-click a guest name to invite.

5. Select a location for your meeting.
   
   Note: By selecting a location from the Guest menu, the location is automatically reserved and no other user can reserve that location. If you type the location of the meeting in the Location field, the location will not be reserved.

6. Select the **Schedule** tab and choose a date and time for the proposed meeting.
   
   Note: The **Auto-Pick** button will find the first available time all your required guests can attend.

7. Select the **Agenda** tab and type an agenda for the meeting (optional).

8. Select the **Options** tab to specify reminder settings and to declare the meeting as **Private** and/or **Flexible**.

9. Select the **Web Conf.** tab to initiate a web conference.

10. Click **Send Proposal** to invite your guests to the meeting.

**Creating an Activity**

You can create an activity in the meetingmaker Java Client to place on your calendar. An activity is any event on your calendar other than a meeting. You can create an activity by doing one of the following:
• Click the **New** icon from the toolbar to open the New Activity dialog box.

• Drag a time on your calendar to open the New Activity dialog box.

**To create an activity on your calendar:**

1. Click the **New** icon on the toolbar.

   or

   Drag your mouse over the desired time.

   The New Activity dialog box displays:

   ![New Activity dialog box](image)

   2. Type a title or topic for the activity in the **Title** field.

   3. Select a date and time for the activity in the **Date** and **Time** fields.

   4. Click **Create** to add the activity to your calendar.

**Note:** If you invite guests to an activity, it becomes a meeting. In an activity, you are the only participant.

**Viewing Messages and Receiving Invitations**

The meetingmaker Java Client Proposals window displays six message types. Unopened messages are displayed in bold type.
To view messages:

1. Click the Messages icon on the toolbar. The Proposals and Messages windows display:

![Screenshot of the Proposals and Messages windows]

2. Double-click one of the six folders to open it. A folder will not open if it does not have any contents. The Active Proposals folder is the only folder containing proposals that you need to respond to. The following six folders are available:

   - **Active Proposals** displays meeting proposals you need to respond to.
   - **To-Do Proposals** displays To-Do proposals you need to respond to.
   - **Your Proposals** displays meetings you have proposed.
   - **Your Refusals** displays meeting proposals you have refused.
   - **CC Proposals** displays meeting proposals you are a CC for.
Using the meetingmaker Java Client

- **CC To-Do Items** displays To-Do items you are a CC for.

3. From the Active Proposals folder, double-click the message you want to open.

4. The Invitation screen displays, detailing the title, location, guests, schedule, agenda, and comments (if any) from the person who proposed the meeting.

5. Respond to the meeting by selecting one of the radio buttons located at the bottom of the Invitation screen.
   - **Yes** informs the proposer that you can attend the meeting and placed the meeting on your calendar.
   - **No** informs the proposer that you can not attend the meeting and placed the message in the Your Refusals folder. The meeting is not placed on your calendar.
   - **I'll decide later** returns the message to your Active Messages folder and allows you to respond at a later date.

**Setting Reminders**

You can set a reminder for any activity or meeting that you propose. The reminder will notify you of the upcoming event.

❖ **To set a reminder:**

1. Select the **Options** tab from the New Activity screen (or Activity Information screen from an activity that is already set).

2. Select the radio button next to the time you want the reminder to occur.

**Creating a To-Do List**

You can create a To-Do list in the meetingmaker Java Client. Like the desktop Client, the Java Client To-Do List can contain both individual and group To-Dos.

❖ **To create a To-Do item:**

1. In the toolbar, click **to do**.
   
   The To Do dialog box appears.

2. Click **New**.
   
   The To-Do Item dialog box appears.
3. Enter a title for the To-Do item. You can also add a date, category, and priority.

4. If desired, enter notes for the To-Do item, and set a reminder time.

5. You can create a group To-Do item by clicking the Participants tab, and adding users, locations and resources to the To-Do.

6. Click Create.

The new To-Do item appears in your To-Do list. You can update the Percent Done to track your progress on the task.

Creating a Contact List

You can create a Contact List in the meetingmaker Java Client. You can use the Contact List to organize business and other contacts who are not meetingmaker users. When you want to create meetings or send email external guests, you can do so directly from the Contact List.

❖ To create a contact:

1. In the toolbar, click contacts.

   The Contact List dialog box appears.

2. Click New.

   The Contact Information dialog box appears.

3. Enter the first and last name of the new contact, email address, and any other business information (e.g. company address).

4. Click OK.

   The new contact appears in your Contact List.

❖ To propose a meeting with external contacts:

1. In the toolbar, click contacts.

   The Contact List dialog box appears.

2. Click the contacts to whom you want to send a meeting proposal. To select multiple contacts, hold down the CTRL key and click the contacts you want.

3. Click Meet.

   The Meeting Proposal dialog box appears.

4. In the Proposal tab, type a name and location for the meeting.
5. Click the **Guests** tab, and add any meetingmaker users who you want to invite to the meeting.

6. Click the **Schedule** tab, and add a date, time, duration, and frequency for the meeting.

7. If desired, add an agenda and set a reminder time.

8. Click **Send Proposal**.

   meetingmaker emails the meeting proposal to the external guests you selected, and sends the proposal to any selected meetingmaker users as well.

---

**To send email to external contacts:**

1. In the toolbar, click **contacts**.

   The Contact List dialog box appears.

2. Click the contacts to whom you want to send email. To select multiple contacts, hold down the CTRL key and click the contacts you want.

3. Click **Mail**.

   Your default email application starts, and a new outgoing email appears. The email addresses of the contacts you selected appear in the recipients list.

4. Type your message in the text area, add attachments and other options as you normally do, and click Send.

   Your email is delivered to the contacts you selected.

---

**Proxies**

A proxy is someone who gives you access to their meetingmaker calendar. You can have read/write or read-only rights to proxy calendars.

**To access a proxy’s calendar:**

1. Select the **Proxy** icon from the toolbar.

2. A list of proxies displays. All proxies you have in your regular meetingmaker client are available through the meetingmaker Java Client.

3. Double-click the name of the proxy whose calendar you want to view.
4. That user’s calendar displays. Use the proxy feature in the meetingmaker Java Client the same as you do in your meetingmaker desktop client. For more information on how to use proxies, see Chapter 9, "Proxies" on page 139.

**Editing User Preferences**

You can set many user preferences in the Java Client. You can change such preferences as your meetingmaker password, Label colors, Contact and To-Do categories, and display time zone.

Note: When you change your user preferences in the Java Client, these changes will be reflected the next time you log in to the meetingmaker desktop Client.

❖ **To set user preferences:**

1. In the toolbar, click Preferences.
   The Preferences window appears.

2. Specify your user preferences:
   - Click **Login** to change your meetingmaker password, and to edit your user information.
   - Click **Labels** to customize your Label colors and Contact List category titles.
   - Click **To-Do** to customize your To-Do priority and category titles.
   - Click **General** to specify how long to keep new proposals, and to enter an address at which to receive email proposals and notifications.
   - Click **Locale** to select your display time zone.

Note: This is your “display” time zone. When you select a display time zone, meetingmaker shows your calendar in the time zone you select. Normally, you should select the time zone in which you live, or spend the majority of your work hours. However, when traveling in a different time zone, for example, you may wish to see your calendar in local time. In this case, select the time zone in which you are traveling.
For more information on display time zones, see “Changing your Display Time Zone” on page 49.

3. Click OK.

meetingmaker saves the user preferences settings you specified.

Other Java Client Features

The meetingmaker Java Client includes features that are not available in the regular meetingmaker client. These include the following:

- **URL Support**
  You can include a URL address in the Agenda screen of any meeting or the Notes field of any activity.

- **Movable Toolbar**
  You can drag the toolbar to any location in the window using the left mouse button.

- **Minimizing a window**
  You can minimize windows by double-clicking the title bar of the window. The title bar remains but the window is minimized.

- **Resize the toolbar**
  You can resize the toolbar by clicking the resize area on the leftmost end.

- **Drag meetings and activities**
  You can drag meetings and activities from your daily calendar to your monthly calendar and from your monthly calendar to your daily calendar. Both calendar views must be open to move events from one to the other.
APPENDIX A

Troubleshooting

This chapter provides information to help you if you encounter problems using meetingmaker.
Topics include:
• A question-and-answer section
• How to contact support
• Things to look for before calling support
• Information to have on hand when calling support
Questions and Answers

Installation and Signing In

If you encounter installation problems, remove all meetingmaker files and reinstall meetingmaker according to the instructions in the *meetingmaker Installation Guide*. For problems signing in, check below for a solution.

Q: Why do I get an error on my PC workstation when I try to install and run meetingmaker from the network file server?

A: You must have read/write access to the network in order to install and run meetingmaker from the network. Have your meetingmaker administrator check your network access.

Q: When I try to sign in, I can’t see the meetingmaker server. What’s wrong?

A: There are several reasons why you might not see a server when you try to sign in. Check with your meetingmaker administrator to make sure that the server is running, and make sure that the correct protocol is selected in the Select Server dialog box, then try again. Your meetingmaker administrator can tell you which protocol to choose.

Q: When I try to sign in to my Windows server from a Macintosh, I do not see IPX in the protocol menu.

A: Make sure that MacIPX (in the Control Panels folder) successfully loads at restart and is set to the proper frame type.

Q: When I try to sign in to my server, there are no servers in the Select Server scroll box when I select IPX from the protocol menu.

A: Check the following:
   • Is the meetingmaker server running?
   • Are you physically or logically connected to your network?
   • Is your network physically or logically connected with the server’s network?
   • If you are on a Macintosh and selected Ethernet in the MacIPX control panel, did you select the same frame type as your meetingmaker server?
   • If you made changes to the MacIPX control panel, did you restart the Macintosh?
<table>
<thead>
<tr>
<th>Q: When I try to sign in to my server from a PC workstation, why is the Protocol menu empty?</th>
</tr>
</thead>
<tbody>
<tr>
<td>A: The <strong>IPC.DRV</strong> and <strong>IPX.DRV</strong> drivers are missing from the <strong>MM</strong> directory. Reinstall meetingmaker.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Q: Why won’t meetingmaker accept my user password?</th>
</tr>
</thead>
<tbody>
<tr>
<td>A: Passwords are case sensitive. Make sure you type it exactly as you created it.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Q: If I have meetingmaker running on my own workstation, can I sign in on a different workstation and check my calendar?</th>
</tr>
</thead>
<tbody>
<tr>
<td>A: Yes. Information will be updated on both machines.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Q: Can I dial in from a hotel room in another city to sign in and update my meetingmaker schedule and respond to new meeting proposals?</th>
</tr>
</thead>
<tbody>
<tr>
<td>A: meetingmaker works over the Internet via TCP or IP. If you have remote access, you can access your meetingmaker account. Check with your system administrator for further information.</td>
</tr>
</tbody>
</table>
Meetings/Activities

Q: I have a Macintosh with a 16-color monitor and cannot see color labels on my meetings and activities, even though I see the color wheel when I go to choose color labels.

A: Color labels in meetingmaker are not available on a 16-color monitor because those colors are reserved for the system color lookup table. If you need to add color to your meeting and appointment blocks, switch your monitor settings to grayscale.

Q: Even though I have something scheduled on my calendar, I am showing up as available for a meeting proposed by someone else. Why doesn't meetingmaker show me as busy?

A: You may have a flexible activity scheduled. If you mark an activity as flexible, other people who are trying to propose meetings with you will not see that as a busy time.

Q: Can I schedule overlapping meetings or appointments?

A: Yes. There will be a black (red on color monitors) conflict bar that allows you to flip back and forth to view the activities.

Q: Can I schedule meetings where attendance is required (even if people have other events scheduled)?

A: You can propose a meeting during time that is already scheduled. The guest can always accept or reject an invitation. The proposer can’t override other meetings which have already been scheduled. You may wish to add a note in the agenda section informing people that attendance is required.

Q: If I propose a meeting and later want to add another guest, do the existing attendees have to get reinvited or will it only send the message to the new person?

A: Each guest will be notified of the change. They don’t have to be reinvited.

Q: If I change the time of a meeting, does it automatically cancel the first meeting?

A: Each guest will be notified of the change and the first meeting will be canceled.

Q: How does meetingmaker notify guests that a meeting was rescheduled?
Each guest receives a notification indicating the time has been changed (that part of the proposal will be underlined).

Can all guests view each other’s comments to a proposal?

Only the proposer can view the comments. Comments can be copied and pasted into the agenda by the proposer so that everyone can see them.

I selected a resource for a meeting after business hours, and it refused the invitation even though I know it is not busy.

Resources that are set as first-come, first served (FCFS) automatically refuse invitations that are outside of their normal work hours. Your meetingmaker administrator can extend the work hours of the resource.
Proxies

Q: Can I have more than one proxy?
A: Yes. You can have an unlimited number of proxies.

Q: Can one person be a proxy to more than one person or resource?
A: Yes.

Q: I designated a proxy to receive all my messages. Why do I still get reminder notifications and instant messages?
A: Only meeting invitations, to-do proposals, and meeting proposal updates go to your proxy. Reminder notifications and instant messages always go to the calendar owner.

Q: I am a message-receiving proxy for a conference room and have discovered that other people who are read-only proxies can schedule the conference room without my receiving a message. What's going on?
A: When you are a proxy for a resource and you invite that resource to a meeting, the resource responds as if it were a first-come, first-served resource.

Printing

Q: I'm trying to print, but no layouts show up in the Print Schedule dialog box. What's wrong?
A: If you have a PC, you must have the MMLAYOUT directory in the meetingmaker directory. If you have a Macintosh, you must have meetingmaker Layouts folder in the Preferences folder inside the System Folder.
UNIX

Q: I want to run meetingmaker for UNIX on my RS6000 (IBM). Is there anyway I can do this?

A: meetingmaker supports Solaris and HP-UX. However, if you have a SPARC server or an HP server available at your site, install meetingmaker on that machine and display its output on your RS6000 workstation.

For example, on RS6000:

xhost +RemoteServer

lets X-clients execute from node RemoteServer on the RS6000 workstation.

On RemoteServer:

mmxp -display RS6000:0

meetingmaker for UNIX now displays on the RS6000 workstation.

Q: I set my variables for MMHOME and XPPATH but I still can't run meetingmaker. Why?

A: meetingmaker is looking for the variable MMHOME. If you set MMHOME as a shell variable and did not export it, meetingmaker can't find it. Set the both MMHOME and XPPATH as follows:

- C Shell: setenv
- Bourne: set followed by export
- Korn: MMHOME= followed by export
- XPPATH= followed by export

Q: Two users are running meetingmaker on different Sun workstations. One workstation's display colors are blue and white, the other's are blue and gray. The fonts are also different. Why?

A: meetingmaker relies on a Xwindows resource file called Mmxp. During installation, this file is put in the directory where the window manager can find it. If meetingmaker was installed under OpenLook, the resource file is put in

/usr/openwin/lib/app-defaults

If meetingmaker was installed under Motif, the resource file is put in

/usr/lib/X11/app-defaults

If you're running a different window manager from your coworker, this could cause display differences.

To change your display, Copy the mmxp resource file to the app-defaults directory for your window manager and restart meetingmaker.
Before Calling Support

The meetingmaker support staff is available to help you with any questions regarding meetingmaker. If a problem occurs with meetingmaker, check the troubleshooting section of this appendix. You may be able to answer your question without the time and expense of a support call.

- Make sure your workstation conforms to the hardware and software requirements.
- Check for viruses. As a precaution, use a virus protection program on a regular basis.

When Calling Support

When calling support, write down any error message associated with the problem and call from near the computer where the problem occurred. In addition, have the following information available to help the Support staff answer your question quickly:

- Computer models involved
- meetingmaker version number
- Operating system version of server and user computer involved

Q  What if I don’t like the default colors and fonts?
A  On an HP, use the window manager to change display options. On a Sun, the default colors and fonts are specified in an Xwindows resource file called Mmxp. This file is located in either /usr/openwin/lib/app-defaults or /usr/lib/X11/app-defaults depending on the window manager. Change colors and font by editing Mmxp.

Q  So what colors and fonts can I use?
A  There are two UNIX commands used to see available colors and fonts on your workstation. To display available fonts, type xlsfonts at the shell prompt.
To display available colors, type showrgb at the shell prompt.
• Any special hardware or network configurations that may affect the problem

• With Macintosh, any special control panels, chooser extensions, system extensions, or network extensions running on the computer.

• With Windows, any special network drivers running on the computer.

Contact meetingmaker Technical Support using one of the methods below:

Telephone: (781) 487-3754
Hours: Mon.-Fri. 9:00 a.m. to 5:30 p.m., US Eastern Time
Fax: (781) 487-3501
Internet: mmhelp@meetingmaker.com

World Wide Web: additional technical documentation is available at support.meetingmaker.com.
APPENDIX B

Icons, Shortcuts, and Menus

This appendix shows the different icons, and calendar and menu shortcuts used in meetingmaker. It also lists menu items and their descriptions.

Topics include:
- Icons
- Shortcuts
- Menus
Icons

Icons are used in meetingmaker to label the status of a name or event.

Guest List

The following table shows the icons used in the Guest List panel and their meanings:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>👤</td>
<td>User invited as a required guest.</td>
</tr>
<tr>
<td>👤</td>
<td>User invited as an optional guest.</td>
</tr>
<tr>
<td>🛡️</td>
<td>Guest busy at the proposed meeting time.</td>
</tr>
<tr>
<td>🛡️️</td>
<td>Status unknown (no server connection or waiting for response).</td>
</tr>
<tr>
<td>📅</td>
<td>Meeting scheduled outside guest's work hours.</td>
</tr>
<tr>
<td>🔒</td>
<td>User receives a CC copy of the meeting proposal.</td>
</tr>
<tr>
<td>🔒</td>
<td>User receives a BCC copy of the meeting proposal.</td>
</tr>
<tr>
<td>✔️</td>
<td>Guest accepted your meeting proposal.</td>
</tr>
<tr>
<td>☐</td>
<td>Guest declined your meeting proposal.</td>
</tr>
<tr>
<td>❓</td>
<td>Guest has postponed response.</td>
</tr>
</tbody>
</table>
**Daily Calendar**

The following table shows the icons used in the Daily Calendar and their meanings:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>Confirmed meeting</td>
</tr>
<tr>
<td>✗</td>
<td>At least one guest has declined a meeting you proposed.</td>
</tr>
<tr>
<td>🔔</td>
<td>Meeting you proposed.</td>
</tr>
<tr>
<td>✧</td>
<td>Activity</td>
</tr>
<tr>
<td><img src="icon" alt="Connected to the server" /></td>
<td>Connected to the server</td>
</tr>
<tr>
<td>✓ <img src="icon" alt="Disconnected from the server" /></td>
<td>Disconnected from the server</td>
</tr>
<tr>
<td><img src="icon" alt="Working offline" /></td>
<td>Working offline</td>
</tr>
</tbody>
</table>
Shortcuts

meetingmaker has shortcuts that allow you to do many of the same tasks you can do from the menu bar.

## Calendar Shortcuts

<table>
<thead>
<tr>
<th>Activity</th>
<th>Macintosh Shortcut</th>
<th>Windows Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>New meeting (daily view)</td>
<td>Option-drag a box over the desired meeting time.</td>
<td>Ctrl-drag a box over the desired meeting time.</td>
</tr>
<tr>
<td>New meeting (monthly view)</td>
<td>Option-double-click on a blank area of the day.</td>
<td>Ctrl-double-click on a blank area of the day.</td>
</tr>
<tr>
<td>New activity (daily view)</td>
<td>Drag a box over the desired activity time.</td>
<td>Drag a box over the desired activity time.</td>
</tr>
<tr>
<td>New activity (monthly view)</td>
<td>Double-click on a blank area of the day.</td>
<td>Double-click over the desired activity time.</td>
</tr>
<tr>
<td>Open a meeting/activity</td>
<td>Double-click the event box.</td>
<td>Double-click the event box.</td>
</tr>
<tr>
<td>Move a meeting/activity</td>
<td>Drag the meeting or activity to a new day or time.</td>
<td>Drag the meeting or activity to a new day or time.</td>
</tr>
<tr>
<td>Copy meeting/activity</td>
<td>Option-drag the meeting/activity to the new location.</td>
<td>Ctrl-drag the meeting/activity to the new location.</td>
</tr>
<tr>
<td>Remove meeting/activity</td>
<td>Select a meeting/activity and press the Delete key.</td>
<td>Select a meeting/activity and press the Backspace (Delete) key.</td>
</tr>
</tbody>
</table>
# Menu Shortcuts

<table>
<thead>
<tr>
<th>Menu</th>
<th>Activity</th>
<th>Macintosh Shortcut</th>
<th>Windows Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Menu</td>
<td>New activity/to-do item</td>
<td>⌘ N</td>
<td>Ctrl-N</td>
</tr>
<tr>
<td></td>
<td>Propose meeting</td>
<td>⌘ M</td>
<td>Ctrl-M</td>
</tr>
<tr>
<td></td>
<td>Open a selected meeting, activity or to-do item</td>
<td>⌘ O</td>
<td>Ctrl-O</td>
</tr>
<tr>
<td></td>
<td>Close a selected meeting, activity or to-do item</td>
<td>⌘ W</td>
<td>Ctrl-W</td>
</tr>
<tr>
<td></td>
<td>Print schedule</td>
<td>⌘ P</td>
<td>Ctrl-P</td>
</tr>
<tr>
<td></td>
<td>Sign out</td>
<td>⌘ L</td>
<td>Ctrl-L</td>
</tr>
<tr>
<td></td>
<td>Exit/Quit</td>
<td>⌘ Q</td>
<td>Alt-F4</td>
</tr>
<tr>
<td>View Menu</td>
<td>Daily Calendar</td>
<td>⌘ D</td>
<td>Ctrl-D</td>
</tr>
<tr>
<td></td>
<td>Monthly Calendar</td>
<td>⌘ Y</td>
<td>Ctrl-Y</td>
</tr>
<tr>
<td></td>
<td>Messages</td>
<td>⌘ E</td>
<td>Ctrl-E</td>
</tr>
<tr>
<td></td>
<td>To-Do List</td>
<td>⌘ T</td>
<td>Ctrl-T</td>
</tr>
<tr>
<td></td>
<td>Go to Day</td>
<td>⌘ G</td>
<td>Ctrl-G</td>
</tr>
<tr>
<td></td>
<td>Find Text</td>
<td>⌘ F</td>
<td>Ctrl-F</td>
</tr>
<tr>
<td></td>
<td>Tile Daily</td>
<td>⌘ I</td>
<td>Ctrl-I</td>
</tr>
<tr>
<td></td>
<td>Master Schedule</td>
<td>⌘ S</td>
<td>Ctrl-S</td>
</tr>
<tr>
<td>Proxy Menu</td>
<td>Proxy 1 (Your Calendar)</td>
<td>⌘ 1</td>
<td>Ctrl-1</td>
</tr>
<tr>
<td></td>
<td>Proxy 2</td>
<td>⌘ 2</td>
<td>Ctrl-2</td>
</tr>
<tr>
<td></td>
<td>Proxy 3</td>
<td>⌘ 3</td>
<td>Ctrl-3</td>
</tr>
</tbody>
</table>
The following tables list the menu items and descriptions found in meetingmaker:

## File Menu

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Activity/To-Do Item</td>
<td>Opens the New Activity dialog box when the Daily or Monthly Calendar is active. Opens the To-Do Item dialog box when the To-Do List is active.</td>
</tr>
<tr>
<td>Propose Meeting</td>
<td>Opens the Meeting Proposal window.</td>
</tr>
<tr>
<td>New Banner</td>
<td>Opens the New Banner window.</td>
</tr>
<tr>
<td>Open Meeting/Activity/To-Do/Message</td>
<td>Opens the selected item.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the currently active window.</td>
</tr>
<tr>
<td>Publish</td>
<td>Opens the Publish Calendar window.</td>
</tr>
<tr>
<td>Export</td>
<td>Exports your calendar to a personal organizer.</td>
</tr>
<tr>
<td>Synchronize Newton</td>
<td>Set connection options for your Newton Message Pad.</td>
</tr>
<tr>
<td>Print Setup</td>
<td>Lets you set defaults (the days, times, fonts, type size, and layouts) for printing your calendar and meeting, activity, and to-do information.</td>
</tr>
<tr>
<td>Print Meeting/Activity/To-Do/Message</td>
<td>Prints details of the selected item.</td>
</tr>
<tr>
<td>Print Schedule</td>
<td>Displays a dialog box that lets you print parts of your schedule in various formats.</td>
</tr>
<tr>
<td>Sign Out</td>
<td>Quits meetingmaker and closes your meetingmaker account. You do not receive any messages until you sign back in.</td>
</tr>
</tbody>
</table>
### APPENDIX B: Icons, Shortcuts, and Menus

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quit/Exit</td>
<td>Quits meetingmaker without signing out. The next time you start meetingmaker, you are signed in automatically.</td>
</tr>
</tbody>
</table>
**Edit Menu**

In addition to the standard commands (Undo, Cut, Copy, Paste, Clear, and Select All), the Edit menu has the following commands:

<table>
<thead>
<tr>
<th>Item Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel Meeting/Activity</td>
<td>Deletes the selected item.</td>
</tr>
<tr>
<td>Delete Message/To-Do</td>
<td></td>
</tr>
<tr>
<td>Address Book</td>
<td>Lets you edit, groups, or resources in your personal address book.</td>
</tr>
<tr>
<td>Proxy List</td>
<td>Lets you select users as proxies.</td>
</tr>
<tr>
<td>Preferences</td>
<td>Lets you configure meetingmaker.</td>
</tr>
<tr>
<td>User Info</td>
<td>Opens the User Information dialog box. Lets you add information about yourself that other users can see.</td>
</tr>
</tbody>
</table>

**Label Menu**

Displays labels used to color-code meetings and activities.

<table>
<thead>
<tr>
<th>Item Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Removes label from a selected meeting or activity.</td>
</tr>
<tr>
<td>Label 1...</td>
<td>Use Preferences to define labels for different categories of meetings or activities.</td>
</tr>
</tbody>
</table>

**Proxy Menu**

Displays a list of people for whom you may act as proxy.

<table>
<thead>
<tr>
<th>Item Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your Name</td>
<td>Displays your calendar.</td>
</tr>
</tbody>
</table>
APPENDIX B: Icons, Shortcuts, and Menus

View Menu
Displays the different ways to view your calendar or to-do list.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proxy names</td>
<td>Opens calendar for the selected person. People on this list have included you on their Proxy List. “R” indicates read-only access.</td>
</tr>
</tbody>
</table>

**View Menu**
Displays the different ways to view your calendar or to-do list.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Daily Calendar</td>
<td>Displays the Daily calendar.</td>
</tr>
<tr>
<td>Monthly Calendar</td>
<td>Displays the Monthly calendar.</td>
</tr>
<tr>
<td>Messages</td>
<td>Displays the Message window.</td>
</tr>
<tr>
<td>To-Do List</td>
<td>Displays the To-Do List.</td>
</tr>
<tr>
<td>Contact List</td>
<td>Displays the Contact List. Lets you create, delete, or modify contacts.</td>
</tr>
<tr>
<td>Go to Day</td>
<td>Use the Navigator to quickly display a selected date.</td>
</tr>
<tr>
<td>Find</td>
<td>Search for text in meeting or activity titles, agendas, comments, or activity notes.</td>
</tr>
<tr>
<td>Tile Daily</td>
<td>Displays a side-by-side view of today’s schedule for all open calendars (yours and any proxies’).</td>
</tr>
<tr>
<td>View Single Day/</td>
<td>Switches between showing one and multiple days on the daily calendar.</td>
</tr>
<tr>
<td>View Multi-day</td>
<td></td>
</tr>
<tr>
<td>Show/Hide Non-</td>
<td>Switches between displaying and hiding weekends or other non-work days.</td>
</tr>
<tr>
<td>Workdays</td>
<td></td>
</tr>
<tr>
<td>Master Schedule</td>
<td>Displays the Master Schedule.</td>
</tr>
</tbody>
</table>

Window Menu
Lists any open meetingmaker windows. Choose an item to display its window.
Menus
This glossary describes the terms used in meetingmaker.

**Activity**
Anything other than a meeting planned on your calendar. Activities on your calendar let other users know you are busy.

**Administrator**
A person who oversees meetingmaker on the network. See the *meetingmaker Administration Guide* for details on the administrator’s duties.

**AppleTalk**
A network protocol developed by Apple Computer, Inc. Most Macintosh-only networks use AppleTalk.

**Auto-Pick**
A feature in the Meeting Proposal window that lets meetingmaker find the first time that all required guests are available for a meeting.

**Banner**
A streamer that you drag across one or more days above the splitter bar of your daily calendar.

**BCC**
A copy of a proposal sent to one or more users without letting other guests or participants see that you’ve done so.

**Busy time**
Scheduled meetings and activities.

**Calendar preferences**
Settings used to customize your calendar display.
Glossary

CC
A copy of a proposal sent to users without inviting them. Other guests or participants see the CC recipient on the guest list.

Composite schedule
Display of busy times for all required and optional guests that appears in the Schedule window to help you choose a meeting time.

Conflict bar
Solid bar on Daily Calendar indicating that two or more meetings or activities are scheduled at the same time.

Cross-platform
Something, usually an application, that works similarly on multiple platforms/operating systems (such as Windows, Macintosh and UNIX). meetingmaker is a cross-platform application.

Duration
Length of time allotted for a meeting or activity.

Flexible activity
An activity that does not show up as a busy time when other people schedule meetings with you.

Frequency
Number of times a meeting or activity takes place (for instance, once a week, once a quarter, or every other Thursday).

Group
A distribution list used to send meeting proposals and to-do requests to several people at one time. meetingmaker has public groups, created by the administrator, and private groups created by users.

Hub
A type of server that connects meetingmaker servers to each other.

Internet HTML Publisher
Posts your calendar, in HTML format, as read-only information on the Internet or an intranet.

Java Client
Allows you to view and use your calendar from a web browser.

Master Schedule
A composite view of busy and free time for a group which has been defined by a user or administrator.

meetingmaker folder
A Macintosh folder containing formats for printing your calendar. Required for printing. See also mmlayout.
<table>
<thead>
<tr>
<th><strong>Meeting proposal</strong></th>
<th>A message proposing the time, date, guest list, and agenda for a meeting.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>mmlayout</strong></td>
<td>A Windows directory containing formats for printing your calendar. Required for printing.</td>
</tr>
<tr>
<td><strong>Navigator</strong></td>
<td>Small calendar display that lets you choose the displayed date on your Daily Calendar or in a date box. Access the Navigator by clicking the Navigator icon.</td>
</tr>
<tr>
<td><strong>Normal work hours</strong></td>
<td>Hours you are available for meetings. You can change your normal work hours with User Info under the Edit menu.</td>
</tr>
<tr>
<td><strong>Normal work days</strong></td>
<td>Days you are available for meetings. You can change your normal work days with User Preferences.</td>
</tr>
<tr>
<td><strong>Notify Preferences</strong></td>
<td>Settings used to determine how meetingmaker notifies you of incoming proposals and messages.</td>
</tr>
<tr>
<td><strong>Protocol</strong></td>
<td>A convention for communicating on a network. meetingmaker supports several protocols.</td>
</tr>
<tr>
<td><strong>Proxy</strong></td>
<td>Someone who can access your calendar to view or schedule meetings and activities on your behalf.</td>
</tr>
<tr>
<td><strong>Purge</strong></td>
<td>Command that deletes calendar data from a server prior to a specific date. This command can only be issued by the meetingmaker administrator.</td>
</tr>
<tr>
<td><strong>Recurring activity</strong></td>
<td>Activity that takes place at regular intervals (weekly, monthly, every other Thursday, etc.).</td>
</tr>
<tr>
<td><strong>Recurring meeting</strong></td>
<td>Meeting that takes place at regular intervals (weekly, monthly, every other Thursday, etc.).</td>
</tr>
<tr>
<td><strong>Resources</strong></td>
<td>Rooms and equipment scheduled with meetingmaker.</td>
</tr>
<tr>
<td><strong>Router</strong></td>
<td>A device or program that connects two types of networks together and maintains addressing information for each network.</td>
</tr>
<tr>
<td><strong>Glossary</strong></td>
<td></td>
</tr>
<tr>
<td>--------------</td>
<td></td>
</tr>
<tr>
<td><strong>Server</strong></td>
<td>A PC, Macintosh or UNIX running server software.</td>
</tr>
<tr>
<td><strong>To-Do items</strong></td>
<td>Tasks you can track on your meetingmaker To-Do List.</td>
</tr>
<tr>
<td><strong>User Preferences</strong></td>
<td>Settings used to customize your calendar to your own work habits.</td>
</tr>
<tr>
<td><strong>Workstation</strong></td>
<td>A desktop computer.</td>
</tr>
<tr>
<td><strong>Zone</strong></td>
<td>A collection of networks on an AppleTalk intranet. A zone can consist of a single network or multiple networks.</td>
</tr>
</tbody>
</table>
Index

A
Acting as a Proxy 44, 142
Active Message 119, 125
Active Messages 119
Activities 108
Activity Notes 110
activity title 109
Adding
  users from another group 105
Address Book 91
Agenda 40, 95
Auto-Pick 40, 93
Auto-Pick, when working offline 98

B
Banner Notes 116
Banners 113
BCC 82, 86

C
calendar
  Daily 46
  Master Schedule 55
  Monthly 51
Calendar Preference 67
Calendar Preferences 62
Cancel Activity 111
Canceling a Scheduled Meeting 101
CC 82, 86
CC Messages 123
CC To-Do Items 123
Changes to a Planned Meeting 103
Changing a Recurring Meeting 101
Changing a Scheduled Meeting 99, 100
Changing Activities 111
Changing an Activity to a Meeting 112
Changing the To-Do List 136
Comments 43, 97, 100, 102
Comments, to-do 135
Composite Schedule 93
Contact with Email 82
Contact without Email 82
conventions 18
Creating a To-Do List 132
Creating Contacts 88
Creating Groups 92
cross-platform application 17

D
Daily Calendar 46
Deleting Messages 124
deleting to-do items 137
Designating Proxies 140
Display Preferences 62

E
Exiting 38
external (email) guests 88

F
Flexibale Activities 111
Flexible Meetings 97
Frequency 94, 109

G
General Preference 72
General Preferences 62
Group To-Do Items 134
Group to-do items 132
Groups 92
groups 104
guest types 86
guest types, external 88
Index

H
Handheld Device 157

I
Individual to-do items 132
Installing Meeting Maker
from a file server to a Macintosh 32
from a file server to Windows 26
from a network file server to Macin-
tosh 30
Installing Meeting Maker for UNIX 36
Installing Meeting Maker for Windows 25
Installing Meeting Maker on a Macintosh
30, 31, 32
Invite Guests 112
Inviting External Guests via SMTP email
90

L
Label Preference 69
Labels 51, 110
Locale Preferences 62
Login Preference 63
Login Preferences 62

M
Macintosh Hardware and Software Re-
quirements (xp) 32
Master Schedule 55
Master Schedule Preferences 62
Master Schedule Preference 71
meeting location 80
Meeting Maker data 23
Meeting Maker server 23
meeting notification 102
Meeting Proposal 97, 112
Meeting Responses 99
Meeting time 93
Meeting title 80
Message Window 120
Messages 43, 100, 102, 104, 119
Modifying Activities 111
Monthly Calendar 51

N
Navigator 61
Newton Preferences 64
Notification 102
notification, meeting 102

O
Once 27
Options 40, 96, 97, 110, 141

P
PalmPilot 157
Password 63
password 38
PC Hardware and Software Requirements
(xp) 27
Preferences 38, 62
Printing 146
printing 145
Private Activites 111
Private Groups 104
Private groups 104
Private Meetings 97
Private To-Do Items 141
Proposing 80, 98
Proposing a Meeting 40, 98
Proposing a meeting 79
proposing a meeting while working of-
line 98
Proposing Group To-Do Items 134
Proxy 44
proxy 139
Public Groups 104
Public groups
deleting 105
Publishable Meetings 97
Q
Quitting 38

R
Read/Write proxy 44, 140
Read-Only proxy 44, 140, 142
Rearranging the To-Do List 137
Recurring Meeting 94, 122
recurring meeting 94
Reminder and Label Options 96, 110
Reply 103
respond to a proposed to-do item 135
Responding 102
Responding to a Meeting Proposal 43, 102
Responding To Proposed Meetings 102

S
scheduling a meeting 93
Scheduling an Activity 41, 108
Scheduling Resources 106
Searching your calendar 54
Selecting guests 40
Send notifications to 141
Send Proposal 97
Signing in for Windows 27
Signing in on a Macintosh 32
Signing in on UNIX 36
Signing Out 38
Sorting Messages 124
Sorting the To-Do List 137
support, technical 202, 203
Sychronizing 157

T
technical support 202, 203
to-do item proposals 121
to-do item proposals 121
To-Do List 131
To-Do Lists 132
To-Do Priority Preference 70
To-Do Priority Preferences 62

U
UNIX Hardware and Software Requirements 35
User Info 76
user list 87

V
View additional information about a user 105

W
well 119, 125
Windows Hardware and Software Requirements 25
Windows Installation 25
Windows NT/95 32-Bit User Installation 25
Working Off Line 98
working offline 24

Y
Your 122
Your Refusals 122